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INTRODUCTION

Thank you for choosing this Icom product. This product is designed and built with Icom’ s state of the art technology
and craftsmanship. With proper care, this product should provide you with years of trouble-free operation.

This instruction manual contains detailed instructions on how to configure your own remote control system.
Before reading this manual, read the RS-BA1 Preparations that comes with the RS-BA1 for details on how to install

the software.

IMPORTANT

PRECAUTIONS

READ THIS INSTRUCTION MANUAL CAREFULLY
before using the software.

SAVE THIS INSTRUCTION MANUAL. This

instruction manual contains important safety and
operating instructions for the RS-BA1.

NOTE: This instruction manual is based on lcom

Remote Utility Version 2.23 and RS-BA1 Version 2.70.
» The software cannot be used with Windows on ARM.

Icom is not responsible for the destruction, damage
to, or performance of any lcom or non-lcom
equipment, if the malfunction is because of:

» Force majeure, including, but not limited to, fires,
earthquakes, storms, floods, lightning, other
natural disasters, disturbances, riots, war, or
radioactive contamination.

» The use of Icom transceivers with any equipment
that is not manufactured or approved by Icom.

IMPORTANT! To remotely control radios using the
RS-BA1, BE SURE that you comply with any local
regulations.

The RS-BA1 is designed to remotely control
transceivers through a LAN port, wireless LAN, or
USB port (Type-B/Mini-B/Micro-B/Type-C).

Proper audio communication cannot be guaranteed if
you connect the Server PC to the transceiver’s ACC
socket, MIC connector, or S/PDIF jack.

Depending on your transceiver, a few functions or
modes cannot be used, or you will need to update the
transceiver’s firmware to operate a CW keyer, using
the RS-BA1 application.

Depending on the PC’s performance, OS, IP provider,
connection type, condition, speed, and so on, the
USB audio may be interrupted, or control by the PC
software may get delayed.

If the CPU has a heavy load, the USB audio is
easily interrupted. The settings of your audio player
application may be changed after connecting a
transceiver to the PC.

To operate your PC and peripheral devices, follow the
instructions provided in their manuals.

All copyrights associated with this manual and all
intellectual property rights associated with the
RS-BA1 application are held by Icom Inc.
Unauthorized reproduction or transmission of this
manual, or any part hereof, is prohibited.

The content of this manual, the software associated
with the RS-BA1, and the appearance of the RS-BA1
are all subject to change without notice.

Icom and the Icom logo are registered trademarks of lcom Incorporated (Japan) in Japan, the United States, the United Kingdom, Germany,

France, Spain, Russia, Australia, New Zealand, and/or other countries.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other

countries.

Microsoft and Windows are trademarks of the Microsoft group of companies.
All other products or brands are registered trademarks or trademarks of their respective holders.



INTRODUCTION

FUNCTIONS AND FEATURES OF Adobe® Acrobat® Reader®

The following functions and features can be used with Adobe® Acrobat® Reader®.
®The screen may differ, depending on the Adobe® Acrobat® Reader® version.

* Keyword search

Click “Find” (Ctri+F) File m View Sign Window Help * Find screen
or “Advanced Search” Hd p—
(Sh|ﬂ+Ctr|+F) in the Edit menu to
open the search screen.
This is convenient when Previous Next
searching for a particular word or 8 “
phrase in this manual. » Advanced search screen
®The menu screen may differ, @ B search = B %
depending on the Adobe® Mere ’ pr———
Acrobat® Reader® version. - -
H Q FEind Ctrl+F Where would you like to search?
© Inthe current decument
Advanced Search Shift+Ctrl+F ) All PDF Documents in
= Search More Tools =t Bonuments =
. . / What word or phrase would you like to search for?
Click to open the find or search Check Spelling )
screen or advanced search screen. DWholewerds iy
Protection » O Include Bookmarks
[ Include Comments
Accessibility 4 =
Preferences... Ctri+K
« Printing out your desired pages. * Read Out Loud feature.
Click “Print” in the File menu, and then select the The Read Out Loud feature reads aloud the text in
paper size and page numbers you want to print. this PDF.
®The printing setup may differ, depending on the Refer to the Adobe® Acrobat® Reader® Help for the
printer. Refer to your printer’s instruction manual details.
for details. (This feature may not be usable, depending on your
®Select “A4” size to print out the page in the PC environment including the operating system.)
original manual size.
Rotate View ]
ﬁ Edit View Sign Window Help L
Page Navigation L
B Open... Ctrl+0O
Page Display 4
Create PDF Zoom '
Save As.. Shift+Ctrl+5 Tools '
Save as Other L: Show,/Hide »
Q; Request E-signatures Display Theme o
1 Ei
(2] Share File Display Size 4
Close Fil Ctrl+W
seserE ' [7] Read Mode Ctrl+H
Properties... Ctrl+D |:i Full Screen Mode Ctrl+L
E Print... Ctrl+P E(,:_j Tracker...
1 Read Out Loud ]




INTRODUCTION

COMPATIBLE TRANSCEIVERS

The RS-BA1 is compatible with Icom transceivers that input and output audio through a LAN port, wireless LAN, or
the USB port (Type-B/Mini-B/Micro-B/Type-C).

Connection type Compatible transceivers
(LTAFZnZ?;zivers it the IC-7851, IC-7850, IC-7800 (Firmware version 3.00 or later), IC-7760,
. IC-7700 (Firmware version 2.00 or later), IC-7610, IC-9700, 1C-905
Server function)
Wireless LAN IC-705
USB port IC-7100, I1C-7200, I1C-7300, IC-7410, IC-7600, IC-7610, IC-7760, IC-7850, IC-7851,
P IC-9100, 1C-9700, IC-705, IC-905
NOTE:

* If your Ilcom transceiver does not have a LAN port, wireless LAN, or a USB port, you can remotely control the
transceiver with an RS-232C interface. However, RS-BA1 operation with transceivers that input or output audio
through the ACC socket, MIC connector, or S/P DIF jack cannot be guaranteed.

» Depending on your transceiver, some functions or operating modes cannot be used.

» Depending on your transceiver, a firmware update may be required to use the CW mode.

The following transceivers are compatible with the RS-BA1 Dualwatch function:
* IC-7851, IC-7850 (Firmware version 1.30 or later)

« IC-7760

* IC-7610 (Firmware version 1.10 or later)
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OVERVIEW OF THE RS-BA1

» The RS-BA1 consists of the Remote Utility, used to configure a remote control system, and the Remote
Controller, used to send the CI-V commands to a Base station, to remotely operate it.
» With the RS-BA1, you can configure a remote control system through a LAN or the Internet.

About the Remote Control system
The RS-BA1 Remote Control system basically consists of the following 3 components:

(D Base station: Transceiver, or Transceiver and Server PC*
@ Network (LAN or Internet)
(® Remote station: PC (Remote PC)

* If you use a transceiver that does not have the Server function, you have to connect a PC to the transceiver.

In the Remote Control system, you can transmit or receive the CI-V commands, control commands to turn the
transceiver ON or OFF, or communication audio through the Remote Utility.
You can remotely control the base station by the Remote PC using the Remote Controller.

A. When using the transceiver with the Server function

:

1

! X

1

1

: ﬁ &
! e INTERNET oF | L AN
: L/
:

1

1

1

1

(1 Base station @ Network

¢

Other station

LAN

Other station

vi



1

BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 11

The Windows operating system includes a firewall setting standard. This is a security function that can prevent
improper access to your PC from the Internet. To let the Remote Utility work properly, add it as an exception in the
firewall.

Right-click the Windows icon, and then click
“Network Connections.”

Installed apps

Power Options
Event Viewer

System

Device Manager

c"°k

isk Manageme:

Shut

Desktop

[52] @ Right-click

Click “Advanced network settings.”

Settings

Network & internet

Finaase § Ethernet
_— Connected

System

Proxy
Proxy server for Wi-Fi and Ethernat

e o Click 5

K Accessiviity

@ Privacy & secury

@ Windows Update

@ Advanced network settings 5
iew all network adapters, network reset

Click “Windows Firewall.”

& setings

® + > Advanced network settings
L _J Local Account
Network adapters

W
T~——— ~—— — ~— -

Related settings

worenemworsarerootons (G | TG IK 2

Windows Firewall @

@ Gethelp

&£ Give feedback

Click “Allow an app through firewall.”

Windows Security

) Firewall & network protection

Who and what can access your networks.

QR Home

D Protection istory

* The “Allowed applications” screen is displayed.

1-1

Click <Change settings>.

B Alowed 3pps -~ o0 x

A « System and Security > Windows Defender Firewall > Allowed 2pps. [¢] Search Control Panel 0

Allow apps to communicate through Windows Defender Firewall
To add, change, o d ports, click Change sett

Click <Allow another app...>.
i Allowed apps - o x
4 <« System and Security > Windows Defender Firewall > Allowed apps v C Search Control Panel 0

Allow apps to communicate through Windows Defender Firewall
o sdd, change, o remove allowed apps and pors, clck Change setings:

What are the isks of allowing an app to communicate? & Change setting

Allowed apps and features:

HEEE
MR EE
R

oK Cancel

» The “Add an app” screen is displayed.
Click “Remote Utility Software for Icom Radios”
and then click <Add>.

Add an app x

- not
2 Remote Utiity Software for Icom Radios ”

Select the app you want to add, or ¢
listed, and then dick OK.

Path —TGram Fiies (86) e YRe  Browse

What are the risks of unblocking an app?
You can choose which netwrk types to add this app to.

Nebwork types 9 Click

* Returns to the “Allowed applications” screen.

In the “Allowed apps and features” list, confirm
that “Remote Utility Software for lIcom Radios” is
displayed and a check mark is in the box, and
then click <OK>.

8 Alowed apps - o0 x

4« System and Securty > Windows Defender Firewsll > Allowed apps v G sechComoibane

o oo

Allow ancthes pp..

= @ Click




1 BEFORE USING THE REMOTE CONTROL SYSTEM

Firewall settings

Windows 10

1. Click the Windows icon, and then click the Setting 6. Click <Allow another app...>.
ICOﬂ P Allowed applications _ o

& v A <« Windows Firewsll » Allowed applications v | | Search Contral Panel p

Allow apps to communicate through Windows Firewall

=1 2
To add, change or remove allowed apps and ports, dlick Change settings.
@ 9 Cllck What are the risks of allowing an app to communicate? &) Change settings
Allowed apps and features:
O

2. Click “Network & Internet.”

Settings - o X

Windows Settings — Click

| ! i |
D @ oK Cancel

Devices Phone Network & Internet
Bluetooth, printers, mouse Link your Android, iPhone wisi, flght mode, VPN

Name. Private  Public ~

v —

a

OD0ONEREEEEE

EOODOREEEEIEAR
omooE®E

» The “Add an app” screen is displayed.
Click 7. Click “Remote Utility Software for Icom Radios”

3. Click “Windows Firewall” and then click <Add>.

P E—— Add an app X

& S Select the app that you want to add or dick Browse to find one that is not
Home tatus listed and then dick OK.

| Find a setting 2 | Network status Applications: 0 c I iCk

T~ T~ ~____ Remobe Utility Software for Icom Radios |
A\ Network troubleshooter
n = & network problems

v Click poperis
Windows Firewall ]
What are the risks of unblocking an app?

Network and Sharing Center ] 9 i
‘You can choose which network types to ade CIICK

Network reset
Network types... Cancel

4. Click “Allow an app through the firewall.”

TS —— * Returns to the “Allowed applications” screen.

9 Firewall & network protection 8. In the “Allowed apps and features” list, confirm
that “Remote Utility Software for Icom Radios” is

I displayed and a check mark is in the box, and

then click <OK>.

§ ternet troubleshooter

Click et
08

o Allowed applications — [u] X
Restore firewalls to default « © A @ <« Windows Firewall > Allowed applications v &| | search Control Panel P
* The “Allowed applications” screen is displayed. Allow apps to communicate through Windows Firewall
. . To add, change or remove allowed apps and ports, click Change settings.
5- CI'Ck <Change SettlngS> What are the risks of allowing an app to communicate? & Change scttings

Allowed apps and features:

M Allowed applications - o x Name Private Public A
« v 4 @@ « Windows Firewall > Allowed applications ~ & | Search Control Panel p E S g
Confi o o
Allow apps to communicate thraugh Windows Firewall Click o onftirm 0o o
To add, change or remove allowed apps and ports, click Change settings. — [u] =]
e vt o
What are the risks of allowing an app to communicate? [
= o o
Allowed apps and features: O g o
Neme Private  Public A O o o
o o o
a (| o o v
Details Remove

Allow another app.

« | @ Click

1-2



1

BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

Before you start using the RS-BA1, the PC’s audio volume of your speakers or headsets must be set to a proper

level.

@® Information

* When several audio devices are used, you must individually set each one.
» Configurable items, displayed screens, and terms may differ, depending on your PC.

» These instructions are based on using Windows 11.

Other station

Settings for the Remote PC

Server PC

(D Base station

1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1
1

(3 Remote station

@ Network

Adjust the volume level of the audio device that is connected to the PC.
* In the “Playback devices” menu, you can adjust the output level of the speaker or headset.
* In the “Recording devices” menu, you can adjust the modulation level sent to the transceiver.

Settings for the Server PC

Adjust the audio input and output level from or to your transceiver.

* In the “Playback devices” menu, you can adjust the modulation level sent to the transceiver.
* In the “Recording devices” menu, you can adjust the audio input level from the transceiver.
® Before adjusting, connect the transceiver and your PC, and turn ON the transceiver. (p. 2-2)

1. Right-click the speaker icon on the taskbar, then
click “Open Sound settings.”
® For the Windows 10, right-click the speaker icon on
the taskbar, then click “Open Sound settings.”

Troubleshoot sound problems

% Open volume mixer

@ Click
~ % o[»] @ Right-click

» The “Sound” screen is displayed.
Click “More sound settings.”
@® For the Windows 10, click “Sound Control Panel.”

System > Sound

& Privacy & security

@ Windows Update More sound settings @

Related support

Click

& Helpwith Sound &

Setting up a microphone

a

& Give feedback

Get help

3. Select the audio device that you use, then click
<Properties>.

2 Sound

Playback s 0 Click ntins

Select a playback device below to modify ts settings:

Q@

-
&’

Speakers
High Definit
Default De

udio Device

@ Select

I
—

Set Default e Click

c

» The “Speaker Properties” screen is displayed.

» Continued on the next page.

1-3



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Adjusting the level of your audio devices

9. Click the <Listen> tab.
If a check mark is inserted in “Listen to this

4. Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

[ Speakers Properties

General || o ClICk fvanced  Spatial sound

ook
I Change lcon

device,” click to remove it.

& Microphone Properties

[ = ] @ Click

You can listen to a portable music player or other device through

this Microphone jack. f you connect a microphone, you may hear
feedback,

‘\_/\/‘\/‘I

Device usage: Use this device (enable) ~ | 9 COI"IfIrm Q = m
p— = (CJiCisten to this devica 9 Confl rm

Flayback through this device:

Default Playback Device ~

5. Click the <Levels> tab.
Adjust the speaker’s audio level by moving the
slide control to the right or left.
@ If the mute setting is turned ON in “Speakers” (),
click the icon to turn it OFF.

10. Click the <Levels> tab.
Adjust the microphone’s audio level by moving the
slide control to the right or left.

@ If the mute setting is turned ON in “Microphone”
(43). click the icon to turn OFF,

8l Speakers Properties X
Genev a Click seuisan & Microphone Properties X
Speakers Genera Us‘r © Click
i — .
i 7o e | @ Adjust
Microphone

. 85

6. After adjusting, click <OK> to close “Speaker @ Adjust
Properties.” ] T

7. Click the <Recording> tab on the “Sound” screen.
In the list, select the audio device that you use,
and then click <Properties>.

11. When connecting the transceiver to the PC
with a USB cable, and when using the RS-BA1

e > Dualwatch function, click the <Advanced> tab
P,ﬁm © Click and then confirm the “Default Format” is set to 2
Select a recording device below to modify its settings: Chan nel .
Fioh bermiion Aucio Deviee § Microphone Properties x
(v] Defaut Device SeIeCt
_ General Listen Leve\s o Click
Default Format
— — Select the sample rate and bit depth to be used when running
- = in shared mode.
2 channgl, 16 bit, 44100 Hz (D Duality] > | g Confirm
- Excusive Mode
Configure et Detaut (5
C IICk 8 Allow applications to take exclusive control of this device
Cancel Apply J 8 Give exclusive mode applications priority

* The “Microphone Properties” screen is displayed.
8. Confirm “Use this device (enable)” is displayed in
the Device Usage menu on the <General> tab.

Restore Defaults

4 Microphone Properties b4
Gereral | o Clic Cancel apely
icrophond
Crange can 12. After adjusting, click <OK> to close “Microphone

Properties.”

- | @ confirm
cancel Aoply

Device usage: Use this device (enable]

1-4



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The RS-BA1 remotely controls the transceivers using CI-V (lcom Communication Interface-V) commands.
See the CI-V command table in the transceiver’s instruction manual for details of the functions that can be controlled.

The following manual settings are required when operating the RS-BA1

Properly preset the items in the table below for functions that cannot be controlled by CI-V commands, or for items
that may cause unintended actions. See the transceiver’s instruction manual for details of the settings or operation.

NOTE:

* Remove the transverter from the transceiver, if it is connected.

» To prevent an accidental transmission, we recommend you remove any key, keypad, or other external devices
connected to the transceiver.

+ Set the transceiver to a normal operating mode. The transceiver cannot receive Cl-V commands in special
modes, such as the firmware update mode, clone mode, terminal mode, or access point mode.

* If the transceiver has the Time-Out Timer function, we recommend that you turn ON the function to prevent the
transceiver from continuously transmitting.

Genre Items Model Contents
RIT function Transceivers without the Server function | Set to OFF.
(Except for the 1C-7100, IC-7300, IC-7600)
ATX function Transceivers without the Server function | Set to OFF.

(Except for the IC-7300, IC-7600)

Simple band scope IC-746PRO*!, IC-7000*", IC-7100, | Set to OFF.
Function IC-7400*", IC-7410, 1C-9100,

SWR Measuring IC-746PRO*", IC-7000*", IC-7100, Set to OFF.

function IC-7400*", IC-7410, 1C-9100

Weather Alert function |1C-7100, IC-705 Set to OFF.

Timer/Sleep Timer Transceivers with the Timer function |Set to OFF.

function

RTTY decode screen

IC-746PRO*", IC-756PROIII*",

Close the screen.

Display IC-7400*"
Volume for the RX All Set to a suitable level.
Volume .
audio
CI-V Baud Rate All (Except for the IC-705, 1C-905) 19200 bps (or “Auto”).
CI-V Address All Desired CI-V Address
@ If other devices are connected to the system,
BE SURE to not set a duplicate address.
Cl-V CI-V USB Port IC-7300%*2, IC-7610*2, 1C-9700*2, Set to “Unlink from [REMOTE].”
IC-7850 (Firmware version 1.10 or later)*?,
IC-7851 (Firmware version 1.10 or later)*?
CI-V USB Baud Rate IC-7300*2, IC-7610*2, IC-9700*?, Set to “115200” (or “Auto”).
IC-7850 (Firmware version 1.10 or later)*2,
IC-7851 (Firmware version 1.10 or later)*2
USB Serial Function Transceivers with a USB (Type-B) port | Set to “CI-V” for the selected
connection method.
Set mode

RS-232C Function

Transceivers with an RS-232C port

Set to “Cl-V” for the selected
connection method.

*1 Operations cannot be guaranteed.
*2 When connecting to the USB port and using the Scope function.

NOTE: When using the IC-PW1, BE SURE to set CI-V Baud Rate to “19200 bps.” After changing the transceiver’s CI-V

settings, be sure to reset the CPU of the IC-PW1 and set the transceiver’s CI-V settings on the IC-PW1. See the IC-PW1
instruction manual for details.
When using the IC-PW2, BE SURE to set CI-V Baud Rate to “19200 bps.” See the IC-PW2 instruction manual for details.

1-5



1 BEFORE USING THE REMOTE CONTROL SYSTEM

Transceiver’s presettings

The following settings are automatically set in the transceiver

When the Remote Controller connects to the transceiver, and you select the model name on the Connect Setting
screen, the following items are automatically set. If you manually operate the transceiver, set these items.

Genre Items Model Contents
MAIN/SUB Tranking IC-7610, IC-7760, Automatically set to OFF.
function IC-7850 (Firmware version 1.10 or later),
IC-7851 (Firmware version 1.10 or later)
SSB/CW Synchronous | All Automatically set to OFF.
Tuning
Calibration Marker Transceivers with the Calibration Automatically set to OFF.
Function Marker function
VOX function All Automatically set to OFF.
Scan function All Automatically cancels the scan.
RTTY filter IC-746PRO*, IC-756PROIII*", Automatically set to OFF.
IC-7400*"
Twin Peak Filter IC-746PRO*!, IC-756PROIII*", Automatically set to OFF.
IC-7400*
Dualwatch function*2 IC-7600, IC-7800, IC-756PROIII*! Automatically set to OFF.
Display SUB band 1C-9100, IC-9700 Automatically set to OFF.
Memory channel/ All Automatically set to the VFO mode.
Call channel
. DR (D-STAR Repeater) |1C-7100, IC-9100, IC-9700, IC-705, |Automatically set to OFF.
Operating | o 4e IC-905
mMode  I'satellite mode IC-9100, IC-9700 Automatically set to OFF.
Type of |DD (Digital Data) mode |1C-9700, IC-905 Automatically set to the FM mode.
emission | ATV (Amateur TV) mode | IC-905 Automatically set to the FM mode.
CI-V transceive All Automatically set to ON.
Cl-v CI-V 731 Mode IC-746PRO*!, IC-756PROIII*", Automatically set to OFF.

IC-7400*"

*1 Operations cannot be guaranteed.
*2 The Dualwatch function is automatically set to OFF when using the Single mode screen
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1 BEFORE USING THE REMOTE CONTROL SYSTEM

Selecting a connection method

There are 3 connection methods. Select one from the following.

When you want to configure the system using a cable, see Section 2.

)

When you want to configure the system using a LAN, see Section 3.
® When using a transceiver with the Server function, you do not need a Sever PC.

- N

RS-BA1

Transceiver
on the 2nd floor

Remote PC

\  onthe 1st floor<

RS-BA1

@Remote station

Base station

GERERED
EERERED
DORERED
EORERED

Transceiver

1-7



B ” CONFIGURING THE SYSTEM THROUGH A CABLE

Examples of the remote control system

This section explains the minimum required settings to operate the transceiver through a cable, using the
following illustration as an example.

You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

RC-28
(Purchase separately)

|

Cable

Transceiver Remote PC

Name: IC-7300
CI-V address. 94h
Baud rate: 19200

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are operating the actual
transceiver’s MAIN dial.

21



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 1. Select a connection method

Check the connector type on your transceiver and see the following chart to connect your transceiver to the PC.

To connect an Icom CI-V command capable transceiver to the PC, you have to make connections for control

command and audio communication.

® The RS-BA1 operation with the PC connected to the transceiver’s ACC socket, MIC connector, or S/P DIF jack for audio
communication cannot be guaranteed.

Transceiver’s Outline
_ Model Ref.
connector Control command Audio
Through a USB cable IC-7100, IC-7200, IC-7300, |p.2-3
IC-7410, IC-7600*",
[USB] port IC-7610, IC-7760, IC-7850,
IC-7851, 1C-9100, IC-9700,
IC-705, 1C-905
Through the CT-17 cI-v Through an audio cable All*2 p. 2-4
LEVEL CONVERTER connected between the (Except for the IC-705, 1C-905)
[REMOTE] jack PC’s audio terminal and the
transceiver’s [ACC] socket
or [MIC] connector
Through an RS-232C Through an audio cable IC-7700*3, IC-7800*3 p. 2-5
cable connected between the
[RS-232C] PC’s audio terminal and the
connector transceiver’s [ACC] socket,
[MIC] connector, or
[S/P DIF] jack

*1 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver's [REMOTE] jack.
*2 To turn the IC-7760 ON or OFF from the Remote Controller, connect to the transceiver’'s [USB] port or directly connect to a
LAN.

*3 To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver's [REMOTE] jack or directly
connect to a LAN.

NOTE: About the USB connection
The USB driver shown below is required to use the RS-BA1.

Model Transceiver’s USB port type Install the driver in the:
IC-7100 Mini-B
IC-7200, 1C-7300, IC-7410, “Driver” > “CP210x” folder*

IC-7600, IC-7610, IC-7850, | Type-B
IC-7851, 1C-9100, 1C-9700

IC-705 Micro-B

IC-905 Type-C “Driver” > “lcom USB Serial Port Driver” folder

IC-7760 Type-B

*When a PC with USB 3.0 port is used to operate the s - B
transceiver, confirm the driver name. If the name “Silicon @ tome Apps & features

Laboratories CP210x USB to UART Bridge (Driver Removal)” T —

is displayed on the Control Panel screen, uninstall it and then
install the latest driver.

Sort by: Filter by: Al

Silicon Laboratories CP210x USB to UART Bridge
(Driver Removal)
Silicon Laboratories
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CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [USB] port:

NOTE: For IC-7600 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’'s [REMOTE] jack.

(p. 2-4)

1

System requirements

* APC that has a USB 1.1, 2.0, or 3.0 port

* Icom CI-V command capable transceiver that
has a [USB] port (Type-B/Mini-B/Micro-B/Type-C)

* The USB cable

Install a USB driver.

CAUTION: DO NOT connect the transceiver to
the PC with the USB cable until the USB driver
installation has been completed.

The driver is not supported by the Windows®
automatic recognition system.

To use the USB cable between the transceiver
and the PC, you must first install a USB driver.
The USB driver comes with the RS-BA1. You can
also download it from the lcom website.

The latest driver and installation guide can be
downloaded from here:
https://www.icomjapan.com/support/firmware_driver/
Read the installation guide before installing the
driver.

2-3

3

Connect the transceiver to the PC.

Connect the transceiver to the PC using the USB
cable.

This guide is based on using a Type-B USB
cable.

USB cable

To [USB]

Server PC

NOTE:

* If you connect a new USB audio device to
your PC, the device selected as the default on
your PC may be changed.

* DO NOT connect another transceiver using a
USB cable while the Remote Ultility is open.
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CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [REMOTE] jack:

NOTE: For IC-7760 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [USB] port or directly
connect to a LAN.

1

System requirements
» APC that has an RS-232C connector
* Icom CI-V command capable transceiver that
has a [REMOTE] jack
* The optional CT-17 CI-vV LEVEL CONVERTER
® Mini-plug cables are included
* An RS-232C cable (Supplied with the CT-17)
+ Stereo audio cables (User supplied)

Connect a remote control system.
Connect the CT-17 to the PC, which enables the
Cl-V communication between them.

Icom transceivers
mini-plug cable

5 Os0f (Supplied with the CT-17)
B=2—— &= o

°Of 88880

X a= [0 ®) O o

B lele|

OQO-I OD O

) — |

: CT17

o

To [RS-232C]
RS-232C cable

(Supplied with the CT-17) .

S

To [RS-232C] 9~15V DG

Server PC
NOTE: The CT-17 accepts only an RS-232C

cable. The use of an RS-232C-USB converter
is not guaranteed.

2-4

Connecting an audio cable

Connect an audio cable between the PC’s audio

ports and the transceiver’s [ACC] socket or

[MIC] connector to enable audio communication

between them.

® See the transceiver’s instruction manual for details
on the connector.

Transceiver PC
AF (Output) = LINE IN/MIC IN (Input)
MOD (Input) € LINE OUT (Output)

e Connect to [ACC]

(Rear panel view) Connect to
) LINE IN
Example: IC-7600 (8 pin) or
MOD MIC IN

- GND
= GND
lﬁ }—’ AF ———————— | 2
D @ B
&_< Not used
. AF

|
|
|
|
I —e/
V]
|
________ |
|
|
® G _ - T

B oo !
|
|
|
|
|
|
|
|
|
|

-

e Connect to [MIC]

Example: IC-7600 (8 pin)
(Front panel view)

MIC input iH_ Connect to

é%o—» GND  104F/16V1 LINE OUT
®®®
©®Q®) i GND

AF output = ———— ! R
Not used
Example: IC-7000 MOD

(Rear panel view)

- =
[T
) — ®MICE +
® MIC input —H—
10pF/16V
CAUTION:

* When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It
can cause a malfunction without adding the
Electrolytic capacitor, as illustrated above.

* DO NOT connect a monaural plug to the PC’s
LINE OUT. It can cause a malfunction.

Server PC



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to a transceiver’s [RS-232C] connector:

NOTE: For IC-7800 or IC-7700 users
To turn the transceiver ON or OFF from the Remote Controller, connect to the transceiver’s [REMOTE] jack or

directly connect to a LAN.

1 System requirements 2 Connect a remote control system.
* APC that has an RS-232C connector Connect an RS-232C cable between the
* Icom CI-V command capable transceiver that transceiver and the PC.

has an [RS-232C] connector

* An RS-232C cable (User supplied)

» Two S/P DIF digital cables or stereo audio
cables (User supplied)

To [RS-232C]

RS-232C cable
(User supplied)

To [RS-232C]

Server PC
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 2. Connecting the transceiver to the PC

When connecting to the transceiver’s [RS-232C] port (Continued):

3 Connecting an audio cables
Connect an audio cable between the PC’s audio port and the transceiver’s [S/PDIF] jack, [ACC] socket, or
[MIC] connector to enable audio communication between them.
® See the transceiver’s instruction manual for details on the transceiver’s connector.

Using the [S/P DIF] jack Using other than the [S/PDIF] jack
Transceiver PC Transceiver PC
S/PDIF OUT > S/PDIF IN (Input) AF (Output) = LINE IN/MIC IN (Input)
(Output) MOD (Input) € LINE OUT (Output)

S/PDIF IN (Input) € S/PDIF OUT (Output)

Connect to
LINE IN
or
MIC IN
GND

e Connect to [ACC] &
(Rear panel view) Not used
AF ]

MOD
= GND
Optical cables =" £ N AF —— 4,
(User supplied) %g :l
L
|
| e
= 11 —_ e Connect to [MIC] !
—— (Front panel view) ! Server PC
+ |
MIC input —H——
Server PC &%o—» GND  10pF/16V | | Connect to
@ 3) ! | LINE OUT
AF output——————I GND
Not used
MOD

CAUTION:

* When using the [MIC] connector, DO NOT
directly connect an audio cable between the
transceiver’s Microphone input and PC. It can
cause a malfunction without adding the Electrolytic
capacitor, as illustrated above.

* DO NOT connect a monaural plug to the PC’s LINE
OUT. It can cause a malfunction.
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STEP 3. Setting the Remote Utility

This section describes how to setup the PC.
® Before configuring the settings, turn ON the transceiver.

1 Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Utility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)

2

® DO NOT use the same name for more than one

PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® Normally, use the default port numbers for
these ports.
Select the network connection type.
Select your Internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
Click <Register> to save the settings.
Click <OK>, and then restart the Remote
Utility.

ahw

N o

Click the Setup that you want to do.

® If no servers or no radios are registered, this screen
is displayed.

Click “Setup for a Local PC (Directly connect the

radio and PC).”

Start the Setup Wizard.
Click <Next>>.

4

2-7

CONFIGURING THE SYSTEM THROUGH A CABLE

Remote Utility X

Set your own PC information.

Click

Settings ?

PC Name Server PC

Control Port (UDP)

Serial Port (UDF)

50003

Audiio Port (UDP)

Language

2 Confirm
|

NetworkComecn 3 Select

@ Select

® Select
® Click

) 4

Remote Utility

The changes will be effect after the application restarts.

[=T]

@

Click

Setup Wizard

Click the Setup that you want to do.

Setup for @ Remate PC
{Aradia with the Server function)

Setup for a Remate PC
{Connect through a Server PC)

=

Setupfora Local PC
{Directly conmect the radio and PC)

Click

Setupfora Server PC
(The radia is acosssibie by Remate PCK))

Setup a Local PC

Start the Setup Wizard

Sefup alocal PC.

Register a Radio that is directly connected to the PC

To continue, click <Next.

Click




2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

Select a transceiver. Registera Radio 7
1. Select a transceiver that you want to add. e s ot ot

(Example: USB)

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click

® If the transceiver is ot listed, dlick <Search>. e S R T A
@® Select “Manual” if the transceiver is connected the radic is connected to the PC using other than a USB cable, select fram the raio from the [Manual]

drop-down list. Then click <Nesdt>

to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list. T B3 Select

2. Click <Next>>.
_[Co1] @ ciik

Set the CI-V/COM port settings. CepErols rox
1. Set the CI-V address, Baud rate, and COM et e r0e o s

PO rt N um be r. If you want to change the CI-V address and/or Baud rate, change from the lists below.

“ » The Radio has the Spectrum scope function, f you use the function on the Remote Corttroler, the USB Baud
® If you select “USB” in step 5, there are no e e e D e L
[REMOTE]".
necessary changes.

2. Click <Next>>.

Search

& [f 1C-7300 comM=3 -

The COM port number is automatically set. ff they are no necessary changes, ick <Next>

Address |94
Baud Rate | 115200 - @ S
et

COM Port Number  (COM3
=[] @ ciick

TIP: When you select “Manual” in step 5 e— T
The Audio Settings screen is displayed. hdo s
. . . . et the audio of the Radio.
Select the devices that input a received audio from
the transceiver and output a modulation signal to the s e ey  ecetved au o the o and oupus 3 e aton o therdks
transceiver, and then click <Next>>. e e -1: () Select
|MOD OutputDevice  [Not used ~| |E @ Select
Device Options
ﬂ ¥ Displays Detected Radio’s Device
I Displays Virtual Device
_=[T=1] ® ek
7 Enter the radio name. Register 3 Radio roox
1. Enter the radio name. e e o 5750,
® The model name and the last 5 digits of the —
Seria| number are entered by default_ This name is displayed on the Radio list screen
. Click <Next>to register to the Radio
2. Click <Next>>.

Ragoteme [C70 | @ Enter

el Lo 1] @ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

The registration of the Radio is complete. Regintera Radio ?
Click <Finish>. Add Completed

The registration o the Radio is completed. To connectto the Radio, using the Radio List screen

Attention:

By connecting the Radio to & LISE port, the defauit settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone:

Inthat case. no sound comes from the original speaker, or you cannot input audio from the micraphone. To
corfim the settings, dlick the <Sound Setfings > button below

Or, if you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows “Sound Settings” screen. f it is set to 1 channel, the receive audio forthe Sub band cannot be
output

Sound Settings

N
[ ok
d

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

D Sound X

Playback F|:cording Sounds Communications

Select a playback device below to modify its settings:

Speakers
High Definition &Audio Device
Default Device

Digital Audio [5/PDIF)

| ool Hioh Definition Audio Device

A Sound X

Playbad| Recording So|lmds Communications

Select a recording device below to modify its settinas:

Microphone
High Definition Audio Device
Default Device

29



2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 3. Setting the Remote Utility

9 Connect the transceiver. [BD tcom remote usiny = x
. File Setup Wizard Options Help
1. Click <_Connect>. - . _ _ Rt | server |
. T_he dialog that notifies the virtual serial port is D
displayed.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

Settings Connect @ Click J MoD | Monitor | Delete

Remote Utility X

Serial port number is (3).

@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

This section describes how to connect and remotely control a transceiver from a PC using the Remote
Controller.
The description in this section is based on the assumption that:
* The transceiver is turned ON.
» The connection to the transceiver using the Remote Utility has succeeded.
(“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Ver2.”
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: IC-7300 (Ver1.42 -))
4. Select the connection between the transceiver and PC in Connection.
(Example: USB)
® If the “MOD Select has also been changed.” dialog may be displayed. Click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: 1IC-7300 XXXXX)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s Cl-V address, and baud rate.
@ If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < ﬂ > or “Exit” on the File menu.
® When the PC shuts down while the Remote Controller application is still running, the transceiver’s power may not
turn OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

[connect Setting x|

tode|
[lcranwenaz-y -] @ Select

Connection

uss =1| @ Select

Er— ORI
Search
Cl

COM Port Baud ratelbps]
] S I i

CI% address CIYY address
Riadi

(Racio) (RSEA1)

94 E0 -

Audio Device [Veice Memon]
ee the
Help file ICOM_VAUDIOAT lcam Vitual dud =

™ IEPWA or IC-Phw2 i connected,
[ Controlled by older commands:.
-

@ CI|Ck @,onwauec\osmgtumsorFmeHadm. |
@ Click
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2  CONFIGURING THE SYSTEM THROUGH A CABLE

STEP 4. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select a connector in MOD Select (Remote ON) (Example: USB), to input transmit audio from the PC to
the transceiver.

3. Click the close button to close the screen.

MIC SET > || ® Click
MOD Select
[Remate OM] @ Select
5B

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
® To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the [F1] key on
your PC’s keyboard.

NOTE:
+ DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click [ in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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CONFIGURING THE SYSTEM THROUGH A LAN

Examples of the remote control system

This section explains the minimum required settings to configure a remote control system through a LAN,

using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s Help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the Help file.

A. When using a transceiver with the Server function (p. 3-2)

E INTERNET
Base station transceiver
(Connect to wireless LAN)
Router

Connect to [LAN]

Base station transceiver

Name: IC-7851abc
CI-V address: 8Eh

Baud rate: 19200

IP address:  192.168.0.10

B. When using the Server PC (p. 3-4)

RC-28
(Purchase

IP address: 192.168.0.1

INTERNET

Server PC

Name: Server PC
IP address: 192.168.0.10
Computer name: ServerPC

Transceiver

® The user ID, password, and other settings in these
illustrations are only examples. Configure the
system using your own settings.

separately)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

RC-28
(Purchase

Router
IP address: 192.168.0.1

3-1

separately)

|

Remote PC
Name: User PC
User ID: USER1

Password: USER0001

TIP: If you use an RC-28 REMOTE ENCODER
connected to the Remote PC, you can use the
RS-BA1 and feel like you are using the actual
transceiver’s MAIN dial.




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function
Set each setting item on the Base station transceiver.

® If you want to connect to the Internet and remotely control the transceiver, see Section 4.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting

Items

Contents

DHCP*'!

ON (Default)

Network Name*'

A Network Name
Example: IC-7851

Network Control

OFF (Default) — ON

Control Port (UDP)

50001 (Default)

Serial Port (UDP)

50002 (Default)

Audio Port (UDP)

50003 (Default)

Internet Access Line

Your Internet access line type
Example: FTTH (Fiber To The
Home)
(Default)

3-2

*1'1f you set DHCP to “OFF” to use the IP address
instead of the network name, or you use an IC-7800
or IC-7700, set the items shown below.

Items Contents
An IP address that is not
IP Address*2 assigned to any other device.

Example: 192.168.0.10
(Default)

Subnet Mask

The subnet mask of the IP

address

Example: 255.255.255.0
(Default)

Default Gateway

An |IP address of the LAN side
on the router
Example: 192.168.0.1

Primary DNS
Server

An IP address of the DNS

Server.

® Normally, enter the default
gateway IP address.

Example: 192.168.0.1

2nd DNS Server

An IP address of the secondary
DNS Server.
® Enter this item if necessary.

*2 \When you use the IC-7760, set “IP Address

(LAN).”



3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

Transceiver registration User registration

Items Contents Items Contents
A Network Radio Name « |AUserlID

Network Radio Name | ® Up to 16 characters Il\ll:)etwork User1/2/3 ® Up to 16 characters
Example: IC-7851abc Example: USER1

A Password

® 8 ~ 16 characters
Network User1/2/3* ;
Transmit audio setting Password @ At least 2 different characters

For the IC-7 IC-77 must be used.
(For the 1€-7800 and I¢-7799) Example: USER0001

NO (Default) —» YES
® When the user is set as an
administrator.

Items Contents
Network MOD Use ON (Default)

Network User1/2/3*
Administrator

* There is no User3 in the IC-7760, IC-7610, IC-9700,
IC-705, and IC-905.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can
possibly guess it. Mix upper and lower case letters,
numbers or characters.

TIP: Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The [POWER] LED slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Shutdown Function
(For the IC-7700, IC-7800, IC-7850, IC-7851)

Power OFF Setting (for Remote Control)
(For the IC-7760, IC-7610, 1C-9700, IC-705, 1C-905)

Standby/Shutdown

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 3-10)

Confirm the transceiver settings described below.

* Network Name or IP Address (For the IC-7760: IP Address (LAN))

* Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode.
When using the IC-7760, keep the RF deck’s main power supply switch ON, and keep the controller’'s power ON or remain
in the Remote Standby mode.
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC

Connect the transceiver to the Server PC and setup the Remote Ultility.
® If you want to connect to the Internet and remotely control the transceiver, see Section 4.

1 Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a
cable.
® See page 2-2 about the connection.

2 Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

3 Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
@® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

akrw

Click the Setup that you want to do.

® If no Servers and no transceivers are registered,
this screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

5 Start the Setup Wizard.
Click <Next>>.

34

Remote Utility X

Set your own PC information.

1 || click

Settings 7 X W
@ Enter

| 50001 ‘

50002 .
Confirm
50003 ®‘

3 Select

@ Select

® Select
® Click

PC Name

Control Port (UDP)

Serial Port (UDP)

Audio Port (UDP)

Language

v

Remote Utility X

The changes will be effect after the applieation restarts.

|

@ Click

Setup Wizard ? X

Setup for & Remote PC
(Connect through a Server FC)

e -

FC Setupfor a Server FC
o and PC) (The radio is accessible by Remote PC(s))

Click the Setup that you want to do.

Setup for a Remote PC
(A radio with the Server function)

=

Setupfor a Local
(Directly connect the radi

Click

Setup a Server PC ? X

Start the Setup Wizard

Setup a Server PC.

Register  Radiathat is directly connected ta the PC to use remote operation from other PCs.

To cortinue, click <Next>




3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

Select a Radio for the Remote operation. Registera Radio 2
1. Select a transceiver that you want to add. s st s et
® If the transceiver has already been registered, Select [new]  you want to register a new radio that is accessble from other PCs
select “Registered radios” and select it from the Orselectfrom [Redistered ados]
dI’Op-dOWﬂ IlSt After selecting. click <Next>
2. Click <Next>>. i
® New:
¢ Registered rados [Select = radio |

_<es| | we- | | Click

7 Selecting a Radio Registe a Radio 5 R
® If you select “Registered radios” in step 6, go to the e e ot et
next page (step 9).

If the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click

1. Select a connection type (Example: USB). e e e B e T
@ If the transceivers are not listed, click <Search>. Kt o comected o the PCusng therthan a USB cale, s o te o fom e (erwal
“ ” . . rop-down list. Then click <Next>.

® Select “Manual” if the transceiver is connected

to the PC using other than a USB cable. Pl e ons ] | s |

H " Manual ither
Select the connected transceiver from the drop- "~ @ select -~
down list.

2. Click <Next>>. [l = | | @ click

8 Set the CI-V/ICOM port settings. B 3

CI-V/COM port Settings

@ If you select “Registered radios” in step 6, go to the <ol the I 730010 D g

next page (step 9).
If you wart to change the CI-V address and /or Baud rate, change from the lists below.
1. Set the CI-V address, Baud Rate, and COM [Tha o e T T i
Port Number.
® If you select “USB” in step 5, there are no
necessary changes. e |4

2. Click <Next>>. N FOK-T
COMPorthumber [coms -]

The COM part number s automaticaly set. f they are no necessary changes, dlick <Next>.

@ Click
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CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

When you select “Manual” in step 7:

The Audio Settings screen is displayed.

Select the devices that input a received audio from
the transceiver and output a modulation to the
transceiver, and then click <Next>>.

Register a Radio ? X

Audio Settings
Set the audio of the Radio

Select the devices that input a recaived audio from the radio and output 2 medulation to the radio,
Ater selecting. dick <Next>

[(4F moutoevice [T - | | ® Select
| MOD Output Device  [not used ] |E @ Select
Device Options
Search

v Displays Detected Radio’s Device

I Displays Virtual Device

9 Register a User to allow a connection.

1.

@ N

No ok

Click <Add>.
» The Add User screen is displayed.
Enter a User ID. (Example: USER1)

Enter a password of more than 8 characters.

(Example: USERO0001)
Click <OK>.

Select a registered user.
Click <Add >>>,

Click <Next >>.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.

Register a Radio ? b

Register a User to allow a connection
Rlegister & User ta allow a cannection 1o 157300,

Register a Userto allow a connection. I no useris registered, cick <Add> to registerthe Add User screen. You
can change this setting later.

Registered Users Accessible Users
Add>>
<<Delete
< Back Mext > Cancel

Add User ? X
[

@ Enter |UserID UsER1 |
pr—— .
3 Enter | R

Cancel
(Example: —-Q

USERO0001) @ Click To set the user as
an administrator,
click to put a
check mark.

v

Register a Radio ? X

Register a User to allow a connection
Register a User to allow a connection to 1C-7300.

Register a Userto allow a connection. f no useris registered, click <Add> to registerthe Add User screen. You

® Click ® Click wew

USERL (Admin) USERT (Admin
i Add>> ]
<<Delete

_<=| | o || @ Click
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. SR &
1. Enter the radio name. T —
® The radio’s model name and the last 5 digits of e
the serial number is entered by default. T el e e
2. Click <NeXt>>_ Click <Next> to register to the Radio
RadoName [1C-7300 | @ Enter

@ Click

11 The registration of the Radio is completed.
Click <Finish>. Register a Redio

Add Completed

The registration of the Radiois completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. no sound comes from the original speaker, or you cannot input aucio from the micraphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, if you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set ta 1 channel. the receive audio for the Sub band cannot be
output

Sound Settings

N

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

3 Sound x

Playback Flacording Sounds Communications

Select a playback device below to modify its settings:

Speakers
High Definition Audio Device
Default Device

Digital Audio [S/PDIF)
Hiah Definition Audio Device

3 Sound X

Playbac| Recording So|nds Communications

Select a recording device below to modify its settings:

Microphone
High Definition Audio Device

o Default Device

NOTE: Before “Step 2. Settings on the Remote PC’s Remote Utility application”
Confirm the Server PC settings described below.

* PC name or IP Address

» User ID and Password registered to the Remote Utility

® Keep the transceiver’s power ON and open the Remote Utility.
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address
If you configure the remote control system through a LAN, Remote stations can access the server using the
Server PC’s computer name (Device name) or IP address.

A computer name is used on networks to identify a particular workstation on the network.
The example below describes how to find out the Server PC’s computer name or IP address to be requested by
Remote stations. Find out your PC’s computer name.

1. Click the folder icon on the taskbar. 3. The “System” screen is displayed. Confirm the
name that is displayed in Device name.
mm Q seacn Zio k O = [Click S
H H 13 H ” H % H ” : >\ = SYStem g AbOUt
2. Right-click “This PC,” and then click “Properties.
e e e Rename this PC
A Home x |+ S B -
| 8 system (@  Device specifications Copy ~
© Biuetooth & devices .
o €%> Home » v G| searchHome » @ Network&internet oo conflrm
SR o o e
> @ OneDiive Open in new tab B Apes Product ID
2 sccouns K
(7 Open in new window panditouct
M pevon; EaRaddireaicaton) ) TR Related links  Domain or workgroup _ System protection  Advanced systerm settings
L Downloads =2 Map network drive. L Garring
o Documents ' Disconnect network drive...
1A Pictures. 5> Pin to Quick access .
@ Music %> _Pin to Start @ CIICK
3 Videos I £ Properties Ale~Enter I
&3 Show more options shift+F10
N @ m
(@ Right-click “*
~ Favorites

25items

1}
[}
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

TIP: Server PC name and IP address (continued)

An IP address is a numerical label that is assigned to devices participating in a computer network.
Find out your PC’s IP address.

1. Right-click the Network icon on the taskbar, and 5. The Ethernet Status screen is displayed, and
then click “Network Connections.” then click <Details...>.
Installed apps I Ethernet Status X
Power Options General
Event Viewer
Connection
System IPv4 Connectivity: Internet
Device Manager IPv6 Connectivity: No network access
Media State: Enabled
Network Connections @ ClICk Duration: 00:35:04
3 e Click
Desktop
Activity
® Right'click Sent .:5 Received
. . Bytes: 7,200,595 o 3,238,805
2. Click “Advanced network settings.”
¥y Properties iy Disable Diagnose
Close

Network & internet

@
WP Local Account

F Ethernet
B ——— Connected

6. The Network Connection Details screen is

displayed, and then confirm the IP address that is
© i displayed in the Address field.
R . ’ Click <Close> to close the window.
CliCk Network Connection Details X
Network Connection Details:
® When using Windows 10, click “Change adapter i o
options” and go to step 4. e e
3. Click “More network adapter options.” oy @] (1) Confirm
P - o x vt Do ey
IPv4 DNS Server
[ * > Advanced network settings IPv4 WINS Server
W wala it NetBIOS over Tepip En.
Network adapters Link4ocal |Pv6 Address
Find a setting a IPv6 Defautt Gateway
e i Ethermet Connecton (218 Disable v IPv6 DNS Servers
T~——— ~— ~_ -
Windows Firewall Click 2 @ Click
PR TIP: When DHCP Enabled is set to “Yes” in the
Network Connection Details screen, the DHCP
: " » C L« ” server assigns a dynamic |P address to your
4. Right-click “Ethernet,” and then click “Status. .
_ 9 PC. Therefore, Remote stations have to match
B R the IP address each time to access the Server
@ Right-click ... .o v PC.
” If DHCP Enabled is set to “Yes,” we
recommend that you let Remote stations
access the Server PC using its computer name.
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STEP 2. Settings on the Remote PC’s Remote Utility application

CONFIGURING THE SYSTEM THROUGH A LAN

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1

2

4

Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Ultility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Utility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: User PC)
® DO NOT use the same name for more than one
PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your Internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
Click <Register> to save the settings.
Click <OK>, and then restart the Remote Utility.

akhw

No

Click the Setup that you want to do.

® If no servers nor no radios are registered, this
screen is displayed.

Click “Setup for a Remote PC (A radio with the

Server function)” or “Setup for a Remote PC

(Connect through a Server PC).”

® Example: “Setup for a Remote PC (A radio with the
Server function)”

Start the Setup Wizard.
Click <Next>>.

3-10

Remote Utility X

Set your own PC information.

— ] Click

Settings 7 x W
© Enter

Control Port (UDP) | 50001 ‘
Serial Port (UDF) 50002 @ C O n fi m
Audio Port (UDP) 50003 |
® Select
Internet AccessLine | |[FTTH id| @ select
© Select
® Click
4
Remote Utility X
The changes will be effect after the applieation restarts.
|
@ Click
Setup Wizard ?
Click the Setup that you want to do.
Click
Setup for a Remote PC Setup for a Remote PC
(A radio with the Server function) (Connect through a Server PC)
Setup for a Local PC Setup for a Server PC
{Directly connect the radio and PC} (The radio is accessble by Remote PCis))

Setup for a Remote PC

Start the Setup Wizard

Setup for a Remote PC.

Register a Radio with the Server function that is connected to a LAN

To continue. click <Next>
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CONFIGURING THE SYSTEM THROUGH A LAN

Enter the Server Information.
1. Enter the transceiver Network Name or IP
Address.
® When using a Server PC, enter the Server PC’s
computer name or IP address. (p. 3-8)
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the User ID and Password.

1. Enter the User ID and Password that are
registered to the transceiver.

2. Click <Next>>.
« After clicking <Next>>, connects to the server.

Adding the Server has been completed.
1. Enter the Server Description.
® The Server Address or Network Name is
entered by default.
2. Click <Finish>.
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STEP 2. Settings on the Remote PC’s Remote Utility application

Add a Server ? x

Server Information
Enter the Server Address or Network Name and Conbol port,

Enter the Server Address or Network Nams. and then click <Next>
ff the Control port of the Server is changed, enter the number.

Server Address or Network Name
1C-7851

| @ Enter
| @ confirm

Control Port (UDF]

50001
< Back Next > @ Click
Add & Server 7 X

User ID and Password
Enter the User D and Password to use to access the Server,

Enterthe User ID and Password that are registered to the Server.
Click <Next>to connect to the Server.

User ID

USER1

password [l @ Enter

(Example: USER0001)

_<es| | e | | (D Click

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

Add a Server ? x

The Server Connection failed

The Server is not found. Cannot connect to the Server.
Click <Back> and confinm the Server address or Network name

Or click <Next> to save the Server.

Cancel

Add a Server ?

Add completed

Addingthe Server has complcted.
Erter the Server description. Click <Finish., f there is nothing to change

@ Enter

Server Description

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
-IC-7851abe

_ [l J]@click
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CONFIGURING THE SYSTEM THROUGH A LAN

STEP 2. Settings on the Remote PC’s Remote Utility application

Configure the settings to connect to the
transceiver.

1.
2.
3.

ok

Select the transceiver.

Click <Settings>.

Click <Recommended>.

» The Select Network screen is displayed.

Select LAN.

Click <Next>.

» The recommended values for your network are

displayed.

Click <Yes> to automatically set the

displayed values in each field of the Network

Setting, then close the Select Network

screen.

Select a virtual COM port number.

® The selected COM port number is used for
CI-V operation with the transceiver.

® When you connect to the transceiver with the
Remote Controller, you have to set the COM
port number.

Select an audio device in Speaker that your

speaker is connected, to output the received

audio from the network.

Select an audio device in Mic that your

microphone is connected, to transmit the

input audio to the network.

10. Click <OK>.
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r Icom Remote Utility — X
File SetupWizard Options Help
Radio List | server List |

IC-7851abe

0 [=10-2)

@ Click

= || (2) Click | | |
. 4

IC-7851abc (IC-7851) ? X
Network Setting

IV AF Transmission [¥ MOD Transmission

Sample Rates 16042 =] [oez -l
Codecs [LPcM 2ch 16bit =] [tpom 1ch 16bit =]
Prebuffer (ms) Ji 80 —J— 100
IV Retransmission Audio Data @ c I ick
Select Netwark ? X

Choose the connection method to a server,

® LA

@ Select

Directly connected or through a network hub,

" Internet

Connected through the Intemet.,
Or connected via VPN, Choose this.

Lt 1] (® Click
A 4

Remote Utiity

Updates the connection information in the fallowing contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2ch 16bit
Prebuffer : 30

MOD Transmission : Enabled
Sample Rates ; BkHz
Codecs : LPCM Tch 16bit
Prebuffer: 100

Retransmission Audio Data: Enabled

1 | ® Click

IC-7851abc (IC-7851) ? X
Netwark Setting

IV AF Transmission ¥ MOD Transmission

Sample Rates [16kHz =] [se =]
Codecs [P 2¢h 16bit =] Jepcm eh 1ebit ]
Prebuffer (ms) — = —f— m
I¥ Retransmission Audio Data Recommended
DNevire Setfinas @ Select
virtual oM Port humber |53 NN - | '
Speaker | Default Device ERE Select

Vic |Default Device = = s
virtual Audio Sample Rates (change effective after the application restarts.) |4§ @ Se |eCt
I

= _1|- 19 Click
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STEP 2. Settings on the Remote PC’s Remote Utility application

[B 1com Remote utilty

9 Connect the transceiver. AL
1. Click <Connect>. =
* The dialog that indicates the virtual serial port is (G785 12be
displayed.
@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

s'|| comnect @ Click J MoD | Moritor | Delete

v

Remote Utility x

Virtual serial port number is (2).

1] @ click

3-13



3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: IC-7851 (Ver1.41 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s Cl-V address, and baud rate.
@ If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < [BJ > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

rEcnnECt Setting X 1

el

|\E 7850/7851 [Ver1 41 -] [DUAL) v| @ Select

@ Select
Remate Lty

[cmee ]| (5 Select
Search
Cl

COM Port Baud rate{bps]
2 hd 19200 hd |

OV addiess CIY address |
Fradio] {RSEAI)

————

Connection

[[cen -

Auio Device [Veice Memon]
ee ine
Help file ICOM_VALDIO (lcom Vitual Aud =

[ [ ICFWA o ICPW2 is connected,
; -

I The radio is automatically set to T side.

@ Click ®:oflwaleclosmgtumsUFFtheHad\o. |
@ Click
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3  CONFIGURING THE SYSTEM THROUGH A LAN

STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

MIC SET @ Click

MOD Select
[Remaote OM] @ Select

LN

MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

NOTE:
* DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Utility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
* When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.
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B 4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

Examples of the remote control system through the Internet

This section explains the minimum required settings to configure a remote control system through the
Internet, using the following illustrations as examples.

® Only the Remote PC users whose ID and password are registered to the Base station transceiver or the Server
PC can connect to it. BE CAREFUL in managing IDs and passwords.

® You can also refer to each application’s help file for assistance with the functions and settings. While the
application is open, push the [F1] key on the PC’s keyboard to open the help file.

A. When using the transceiver with the Server function (p. 4-6)

e

INTERNET

|

Router Router

RC-28
(Purchase
separately)

|

-,

Base station transceiver
(Connect to wireless LAN)

Base station transceiver
Name: IC-7851abc Name: User PC
Cl-V address:. 8Eh

UserID: USER1
Baud rate: 19200 Password: USER0001

Remote PC

B. When using the Server PC (p. 4-8)

AN

Router Router RC-28
(Purchase
separately)
Transceiver Server PC Remote PC
Name: Server PC Name: User PC
IP address: 192.168.0.10 User ID: USER1
Domain name: ServerPC Password. USER0001
® The user ID, password, and other settings in these TIP: If you use an RC-28 REMOTE ENCODER
illustrations are only examples. Configure the connected to the Remote PC, you can use the
system using your own settings.

RS-BA1 and feel like you are using the actual
transceiver’s MAIN dial.




4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

If you configure the remote control system through the Internet, PCs can connect to the transceiver using its public
IP address or domain name.

< To let PCs connect to the Base station using its public IP address

A public IP address is an address that is accessible over the global Internet. Check the router’s manual about how
to configure your router to set the public IP address.

NOTE:

* If you have a dynamic public IP address, we recommend that you use the Dynamic DNS service to enable the
PCs to connect to the transceiver.

* If the PC connected to the transceiver is not using the Dynamic DNS service, you need to change setting of
PC’s Remote Utility to connect to the transceiver each time its public IP address changes.

INTERNET
IP address
WAN:  skskok skeoksk skksk skekok R Rout
LAN:  192.168.0.1 outer outer
A
Server PC
Base station transceiver
(Transceiver with Remote PC
the Server function)
Request “skskesk skekesk skskesk sksksk”
(Public IP address)
Transceiver
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

About a public IP address and the Dynamic DNS service

< To let PCs connect to the Base station using its domain name

If you set up an account for a Dynamic DNS server, the DNS server resolves the domain name into your dynamic
IP address. Using the domain name, PCs can connect to the Base station through the Internet, even if the Base
station’s public IP address is changed.

® Check the router’s manual about how to configure your router to use the Dynamic DNS services.

Dynamic DNS

Server QX

Update with your

INTERNET
dynamic IP address
IP address /
WAN:  skeskesk skekesk skeskesk skeksk
LAN: 192.168.0.1
Domain name: Router Router
icom-rsbal.com
A
Server PC

Base station transceiver
(Transceiver with
the Server function)

Remote PC

Request “icom-rsbal.com”
(Domain name)

Transceiver
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Port forwarding

CONFIGURING THE SYSTEM THROUGH THE INTERNET

If you configure the remote control system through the Internet, you need to configure your router to enable

connections from the Internet.
To enable connections, forward the port used with the Remote

Utility.

NOTE: Icom is not responsible for any accidents caused by the security degradation after this port forwarding.

INTEF

Forwarded port numbers

50001 ~ 50003 Router

Server PC

192.168.0.100

Base station transceiver
(Transceiver with
the Server function)
Static IP Address:

192.168.0.100
Transceiver

Example: The transceiver directly
connected to the network

Example: The transceiver connected t
network through a PC

Default Gateway: 192.168.0.1

4-4

Static IP Address:

RNET

Forwarded port numbers

Router 50001 ~ 50003

Remote PC

Static IP Address: 192.168.0.100
Default Gateway: 192.168.0.1

DNS Server address: 192.168.0.1
o the



4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

Port forwarding

Set the static local IP address to the Base station or Server PC.
Set a static local IP address to the Base station or Server PC.

® Information
» Usable IP addresses differ, depending on your router. Check the router’s manual for details.
» DO NOT set the same IP address to 2 or more devices that are connected to the same router.
» Check your PC’s manual about the setting details.

Transceiver setting

Items Contents
DHCP ON (Default) — OFF

An IP address that is not assigned to any other device.
Example: 192.168.0.10 (Default)

The subnet mask of the IP address
Example: 255.255.255.0 (Default)

An IP address of the LAN side on the router
Example: 192.168.0.1

An IP address of the DNS Server.
Primary DNS Server | ® Normally, enter the default gateway IP address.
Example: 192.168.0.1

An |IP address of the secondary DNS Server.
® Enter this item if necessary.

Control Port (UDP) 50001 (Default)
Serial Port (UDP) 50002 (Default)
Audio Port (UDP) 50003 (Default)

IP Address*

Subnet Mask

Default Gateway

2nd DNS Server

* When you use the IC-7760, set “IP Address (LAN).”

2 Forward the port.
» Forward port numbers that are used for the RS-BA1. (Default: 50001 ~ 50003)
» “UDP” should be used as the port protocol.
» Set a static local IP address in step 1 as a destination port.
® Check the router’s manual about how to forward ports.
® Depending on the router settings, you must configure the IP filter settings. Check the router’s manual how to configure
the settings.
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function
Set each setting item on the Base station transceiver.

NOTE: When you change a setting that displays “(Valid after Restart),” you must restart the transceiver after
setting. After restarting, keep the transceiver’s power ON or remain in the remote standby mode.

Network setting

User registration

Items

Contents

Items Contents

Network Control

OFF (Default) — ON

Internet Access Line

Your Internet access line type
Example: FTTH (Fiber To The
Home)
(Default)

4-6

A User ID
® Up to 16 characters
Example: USER1

Network User1/2/3*
ID

A Password

® 8 ~ 16 characters

® At least 2 different characters
must be used.

Example: USER0001

Network User1/2/3*
Password

+ |NO (Default) — YES
Egmzr:t;f:rm 213 ® When the user is set as an
ini administrator.

* There is no User3 in the IC-7760, IC-7610, IC-9700,
IC-705, or IC-905.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can
possibly guess it. Mix upper and lower case letters,
numbers or characters.



4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< A. When using a transceiver with the Server function (Continued)

Transceiver registration

Items Contents

A Network Radio Name
Network Radio Name | ® Up to 16 characters
Example: IC-7851abc

Transmit audio setting
(For the 1IC-7800 and IC-7700)

Items Contents
Network MOD Use ON (Default)

TIP: Standby mode setting

To remotely control the transceiver using the RS-BA1, the transceiver should be turned ON or be in the standby
mode.

To set the transceiver in the standby mode, set the item described below and select

“Standby (for Remote Control)” on the displayed screen when you turn OFF the transceiver.

® The LED above [POWER] slowly blinks orange if the transceiver is in the standby mode.

Items Contents

Shutdown Function
(For the IC-7700, IC-7800, IC-7850, IC-7851)

Power OFF Setting (for Remote Control)
(For the IC-7760, IC-7610, 1C-9700, IC-705, IC-905)

Standby/Shutdown

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-12)

Confirm the settings described below.

* Public IP address or Domain name (p. 4-2)

* Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode.
When using the IC-7760, keep the RF deck’s main power supply switch ON, and keep the controller’'s power ON or remain
in the Remote Standby mode.
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STEP 1. Settings on the Base station

CONFIGURING THE SYSTEM THROUGH THE INTERNET

< B. When using the Server PC
Connect the transceiver to the Server PC and setup the Remote Utility.

1

5

Connect the transceiver to the Server PC.
Connect the transceiver to the Server PC with a
cable.

® See page 2-2 about the connection.

Open the Remote Utility.
1. Open “lcom Remote Utility.”
2. “Set your own PC information.” is displayed,
then click <OK>.
® When you first open the Remote Utility, this
screen is displayed.

Configure the settings.
® When you first open the Remote Ultility, this screen
is displayed.
1. Enter a name for your PC of up to 16
characters. (Example: Server PC)
@® DO NOT use the same name for more than
one PC on your network.
2. Confirm the port numbers of the Control,
Serial and Audio ports.
® You should use the default port numbers for
these ports.
Select the network connection type.
Select your internet access line type.
Select the software display language.
® The selected language will be used as the Help
file language.
6. Click <Register> to save the settings.
7. Click <OK>, and then restart the Remote Utility.

ok w

Click the Setup that you want to do.

® If no Servers and no radios are registered, this
screen is displayed.

Click “Setup for a Server PC (The radio is

accessible by Remote PC(s)).”

Start the Setup Wizard.
Click <Next>>.

4-8

Remate Utility X

Set your own PC information.

[ =] click

Settings ? X W

e [EE] @ Enter
Control Port (UDP) ‘ 50001 ‘

Serial Port (LIDP) ’W @ Confirm
Audia Port (UDP) 50003 |

® Select
@ Select
Language

® Select

Remote Utility X

The changes will be effect after the applieation restarts.

oo

@ Click

Setup Wizard ? X

Click the Setup that you want to do.
Setup for a Remote PC
{Aradio with the Server function)

=

Setupfor a Local PC
(Directly connect the radio and PC)

Setup for a Remote PC
{Connect through a Server PC}

- -

Setupfor a Server FC
(The radio is accessible by Remate PC(s))

Click

Setup a Server PC

Start the Setup Wizard

Setup a Server PC,

Register a Radio that is dirsctly connected to the PC to use remote operation from other PCs.

To cortinue. click <Mext>

. [T] ik
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STEP 1. Settings on the Base station

< B.

6

8

CONFIGURING THE SYSTEM THROUGH THE INTERNET

When using the Server PC (Continued)

Select a Radio for the Remote operation.
1. Select a transceiver that you want to add.

@ If the transceiver has already been registered,
select “Registered radios” and select it from the
drop-down list.

2. Click <Next>>.

Selecting a Radio
® If you select “Registered radios” in step 6, go to the
next page (step 9).
1. Select a connection type (Example: USB).
@ If the transceivers are not listed, click <Search>.
® Select “Manual” if the transceiver is connected
to the PC using other than a USB cable.
Select the connected transceiver from the drop-
down list.
2. Click <Next>>.

Set the CI-V/ICOM port settings.
® If you select “Registered radios” in step 6, go to the
next page (step 9).

1. Setthe CI-V address, Baud Rate, and COM
Port Number.
@ If you select “USB” in step 5, there are no

necessary changes.
2. Click <Next>>.

4-9

Register a Radio ? b

Select a Radio for Remote operation
Select a Radio that i accessible from other PCs,

Select [new] f you want to register a new radio that is accessble from other FCs
Or select from [Registered radios].

After selecting. click <Next>

@ Few!

" Registered radios |Select a racio

_<es| | we- | | Click

Register a Radio ? X

Selecting a Radio
Select a Radio that you wart to add

[ the radio is connected to the PC using a USB cable, select the radio from the [USB] drop-down list. Then click.
<MNext>. I the radio is not listed. confirm the radio is ON and the cable is fimly connected. Watt for a while until
the PC recognizes the device, and then click the <Search> button

I the radio is connected to the PC using otherthan a USE cable, select from the radio from the [Manual]
drop-down list. Then click <Next>

1C-7300 COM=3 A

Search

© [

T B @) Select

~=oa

Register a Radio ? 53

CI-V/COM port Settings
Set the IC-7300's C14 settings.

¥ you wart to change the CHV address and/or Baud rate, change from the lits belaw.
The Radio has the Spectrum scope function. f you se the function on the Remote Controllr, the USB Baud
rate must be set to 115200 bps. At this time, also corfirm the setting of the CI-V USB Port item is "Unlink to
[REMOTET".

The COM port number s automaticaly set. I they are no necessary changes, dlick <Next>

Address |94
Baud Rate |115200 hd

@ Set
COM Port Number |COM3

] @ cii
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CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

When you select “Manual” in step 7:

The Audio Settings screen is displayed.

Select the devices that input a received audio from
the transceiver and output a modulation to the
transceiver, and then click <Next>>.

r
Register a Radio ? X

Audio Settings
Set the audio of the Radio

Select the devices that input a received audio from the radio and output a modulation to the: radio
Ater selecting, click <Next>

[FFrpittene  ArE— s @ Select
| MOD Output Device |N0tused v‘ |£ @ select
ﬂ Device Options

¥ Displays Detected Radio’s Device

I™" Displays Virtual Device

9 Register a User to allow a connection.

1.

@ N

No ok~

Click <Add>.
» The Add User screen is displayed.
Enter a User ID. (Example: USER1)

Enter a password of more than 8 characters.

(Example: USERO0001)
Click <OK>.

Select a registered user.
Click <Add >>>,

Click <Next >>.

NOTE: To prevent unauthorized access

Set a long and strong password so that no one can possibly guess it. Mix upper and lower case letters, numbers
or characters.

Register a Radio ? b

Register a User to allow a connection
Rlegister & User ta allow a cannection 1o 157300,

Register a Userto allow a connection. I no useris registered, cick <Add> to registerthe Add User screen. You
can change this setting later.

Registered Users Accessible Users
Add>>
<<Delete
< Back Mext > Cancel
[ada User 7 x

@ Enter [ms
Password | 7 % adnin €
® Enter =T 1 <
I Cancel
(Example: 7-

USER0001) @ Click To set the user as
an administrator,
click to put a
check mark.

v

Register a Radio ? X

Register a User to allow a connection
Register a User to allow a connection to 1C-7300.

Register a Userto allow a connection. f no useris registered, click <Add> to registerthe Add User screen. You

® Click ® Click wsewe

USERL (Admin) USERT (Admin
i Add>> ]
<<Delete

_<=| | o || @ Click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 1. Settings on the Base station

< B. When using the Server PC (Continued)

10 Enter the radio name. SR 6 &3
1. Enter the radio name. Hﬂ:':la’r‘l)::'readmname of the IC-7300
® The radio’s model name and the last 5 digits of R,
the serial number is entered by default. [EE=E e
2. CIiCk <Next>>_ Click <Next> to register to the Radio
RodoName [1G73000 0 @ Enter

11 The registration of the Radio is completed.
Click <Finish>. Register a Radio 5

Add Completed

The registration of the Radiois completed. To connect to the Radio, using the Radio List soreen

Attention:

By connecting the Radiato a USB port, the defaut settings on the REC/PLAY device window may change to
the Radio’s Speaker and Microphone.

Inthat case. no sound comes from the original speaker, or you cannot input aucio from the micraphone. To
confim the seftings, cick the <Sound Setfings> button below.

Or, if you use Dualwatch, make sure that the Microphone of the USB audio is set to 2 channels on the

Windows "Sound Settings” screen. If it is set ta 1 channel. the receive audio for the Sub band cannot be
output

Sound Settings

N

By connecting the transceiver to a USB port,
the default settings on the REC/PLAY device
window may change to the Radio’s Speaker
and Microphone. To confirm the settings, click
<Sound Settings>.

3 Sound x

Playback Flacording Sounds Communications

Select a playback device below to modify its settings:

Speakers
High Definition Audio Device
o Default Device

| Digital Audio [S/PDIF)

Hiah Definition Audio Device

3 Sound X

Playbac| Recording So|nds Communications

Select a recording device below to modify its settings:

Microphone
High Definition Audio Device
Default Device

NOTE: Before “STEP 2. Settings on the Remote PC’s Remote Utility application” (p. 4-12)
Confirm the settings described below.

* Public IP address or Domain name

» Base station’s Network User ID and Password

® Keep the transceiver’s power ON, or remain in the Remote Standby mode

4-1



4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

This section describes how to setup the Remote PC.
® Before configuring the settings, connect a speaker and microphone or headset to the PC.

1 Open the Remote Utility. Remete Uiy x
1. Open “lcom Remote Utility.”

2. “Set your own PC information.” is displayed, .
then click <OK>. | click
® When you first open the Remote Ultility, this

screen is displayed.

Set your own PC information.

2 Configure the settings. setings ER
® When you first open the Remote Ultility, this screen P tame @ Enter
is displayed. Control Port (ubP) 50001 ‘

1. Enter a name for your PC of up to 16 sentpotuon) [0 .
characters. (Example: User PC) e ®\ Confirm
® DO NOT use the same name for more than Networ Comnection 3 Select

one PC on your network. Intermet Access Line @ Select

2. Confirm the port numbers of the Control, Language (® Select
Serial and Audio ports. ® Click

® You should use the default port numbers for

these ports. v

3. Select the network connection type. _
4. Select your Internet access line type. e )
5. Select the software display language. The changes il e ftecaier e spalction estart

® The selected language will be used as the Help ‘

file language.
6. Click <Register> to save the settings. @ Click
7. Click <OK>, and then restart the Remote Utility.
3 Click the Setup that you want to do. Setup Wizard ToX
® If no servers nor no radios are registered, this Cick the Setup that you want to do.
screen is displayed.

Click “Setup for a Remote PC (A radio with the » L. _@
Server function)” or “Setup for a Remote PC <=8 | click
(Connect through a Server PC).” e e

® Example: “Setup for a Remote PC (A radio with the

Server function)’ ‘a @ _

Setup for a Local PC Setup for a Server PC
{Directly connect the radio and PC) (The radio is accessble by Remote PC(s))

4 Start the Setup Wizard. Setap for  Remote PC 7 x
C||Ck <Next>>. Start the Setup Wizard

Setup for a Remote PC

Register a Radio with the Server function that is connected to a LAN

To continue, click <Next>,

4-12
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STEP 2. Settings on the Remote PC’s Remote Utility application

5 Enter the Server Information. Aeld s Server rox
1. Enter the Base station’s domain name or et s s et e nd Cortlpot

public IP Address.
2. Confirm the Control Port number.
® You should use the default port number for this
port.
3. Click <Next>>.

Enter the Server Address or Network Nams. and then click <Next>
ff the Control port of the Server is changed, enter the number.

Server Address or Network Name
[oreme | ) Enter

Control Port (UDF]

oo | @ confirm

_<ex| | > | | (3 Click

Enter the User ID and Password. prrpr— PR
1. Enter the User ID and Password that are

registered to the transceiver.
2. Click <Next>>. O o S o e re 0 he Server

« After clicking <Next>>, connects to the server.

User ID USER1

password [l @ Enter

(Example: USER0001)

_ e | e | | Q) Click

TIP: If you cannot connect to the server, an error
dialog is displayed.
Click <<Back>, and confirm the settings.

r
Add a Server ? X

The Server Connection failed

The Server is not found. Cannot connect to the Server.
Click <Back> and confimm the Server address or Network name

Or click <Next>to save the Server.

Cancel

7 Adding the Server has been completed. R servr 2
1. Enter the Server Description. Add completed
® The Server Address or Network Name is
entered by default. "Effe‘??h'!ifil‘fé!::néﬁ?n"‘%ﬁ <Finish>. f there is nothing to change.

2. Click <Finish>. e
[ @ Enter

The following radios that are registered to the Server are added to the Fadio List
To connect to the radio, using the Radio List screen,
-IC-7851abe

=1 @ciick
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

8 Configure the settings to connect to the Base r ey - *
A File SetupWizard Options Help
station. ) Radio List | server List |
1. Select the transceiver. IC-7851abc

2. Click <Settings>.

3. Click <Recommended>.

» The Select Network screen is displayed. e e

Select Internet. -

Click <Next>. ® Click

» The recommended values for your network are

displayed.

6. Click <Yes> to automatically set the
displayed values in each field of the Network
Setting, then close the Select Network
screen. |—| .

7. Select a virtual COM port number. =] @ Click l ‘ l
® The selected COM port number is used for v

CI-V operation with the transceiver.
® When you connect to the transceiver with the 788 age (com b com) TX
Remote controller, you have to set the COM = — ¥ oD Transmisson
port number. SampleRates  [1ek =] o=

=]
. . . Codecs [Lpcm 2ch 16bit ~| [Lpc 1ch 16bit |
8. Select an audio device in Speaker that your e o S o

speaker is connected, to output the received R @ Click
audio from the network.

9. Select an audio device in Mic that your v
microphone is connected, to transmit the
input audio to the network.

10 C||Ck <OK>_ Choose the connection method to a server.

" Lan

ok

Select Netwark ? X

Directly connected or throuch a network hub.

@ ftemet

Connected through the Intemet. @ Select

Or connectad via VPN, Choase this, ‘

L= 1|® Click
4

Remote Utility

Updates the connection information in the following contents, OK?

AF Transmission : Enabled
Sample Rates : 16kHz
Codecs : LPCM 2ch 16bit
Prebuffer: 120

MOD Transmission : Enabled
Sample Rates : 8kHz
Codecs : LPCM 1ch 16bit
Prebuffer: 150

Retransmission Audio Data: Enabled

1C-7851abc (icom-rsbal.com) ? X
Netwark Setting
¥ AF Transmission [¥ MOD Transmission
Sample Rates [1561z =] [se =
Codecs [Lpcm 2ch 16bit =] [pcM 1ch 166it =]
Prebuffer (ms) —— > — f—— =
[¥ Retransmission Audio Data M
Device Setfinas @ Select
virtusl oM Port humber |[SE T NNN— - | :
Specker |Default Device ~11= 8 Select
Mic | Defaut Device = s
Virtuzl Audio Sample Rates (change effective after the application restarts.) |4
© Select
)
OK H
- (0 Click
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4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 2. Settings on the Remote PC’s Remote Utility application

[B 1com Remote utilty

9 Connect the transceiver. AL
1. Click <Connect>. =
* The dialog that indicates the virtual serial port is (G785 12be
displayed.
@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-2)
2. Click <OK>.
« “<<Connected>>" is displayed under the radio
name when the connection has succeeded.

s'|| comnect @ Click J MoD | Moritor | Delete

v

Remote Utility x

Virtual serial port number is (2).

@ Click

4-15



4  CONFIGURING THE SYSTEM THROUGH THE INTERNET

STEP 3. Starting the Remote control operation

This section describes how to connect and start remotely controlling a transceiver from a Remote PC
using the Remote Controller.

The description in this section is based on the assumption that the connection to the transceiver using the Remote
Utility has succeeded. (“<<Connected>>" is displayed under the radio name.)

1 Connect setting using the Remote Controller application
1. Open “RS-BA1 Remote Control Version 2.
2. Click < > in the toolbar, or click “Connect Setting...” in the Option menu.
» The Connect Setting screen is displayed.
® You cannot change the settings while the transceiver is connected to the Remote Controller.
3. Select a transceiver to access using the Remote Utility application, in Model.
(Example: IC-7851 (Ver1.41 - ) (DUAL))
4. Select the connection between the transceiver and PC in Connection. (Example: LAN)
® When the “MOD Select has also been changed.” dialog is displayed, click <OK>.
® The confirmation dialog for the connection setting may be displayed, depending on the transceiver. If connected
correctly, click <OK>.
5. Select a transceiver to access using the Remote Utility application, in Remote Utility.
(Example: IC-7851abc)
» The CI-V settings are automatically loaded from the Remote Utility application to CI-V. The settings include the
virtual COM Port number, transceiver’s Cl-V address, and baud rate.
@ If the desired transceiver is not displayed in Remote Utility, click <Search> to load the transceiver’s information
from the Remote Utility application.
6. Check “Software closing turns OFF the Radio.” to turn OFF the transceiver when the Remote
Controller application is closed by clicking < [BJ > or “Exit” on the File menu.
® When you shut down the PC while the Remote Controller application is still running, the transceiver may not be
turned OFF.
® For other settings, see the Remote Controller’s Help file.
7. Click <OK> to save the settings and close the screen.

rEcnnEct Setting X 1

Modl
| 1C-7850/7851 [Ver1 41 -] [DUAL) v| @ Se Iect

Coarnection

L - @ Select

Femote Utility

[cemee ]| (5 Select
Search | |
Cl

COM Port Baud rate{bps]
2 hd 19200 hd

CIV address CIV address
(Radic) (R5-BA1)

See the “Audio Deviee [Voice Memory)
He|p file I1COM_VAUDIO- [lcom Yirtual Aud -

[ [ ICPW1 or ICPW2 is connectzd,
; r

| The radio is automatically set to T, side.

@ CI|Ck @:onwareclosmgtumsUFFmeRam. |
@ Click
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STEP 3. Starting the Remote control operation

2 Connecting to the transceiver using the Remote Controller application
Click < [[8] > in the toolbar, or click “Connect ON” in the File menu.
* When the connection has succeeded, the transceiver’s current data will be displayed on the main panel.

3 Selecting a modulation input connector
To transmit audio when remotely controlling the transceiver from the Remote Controller, configure the

following settings, depending on the transceiver’s connector.

1. Click <MIC SET> on the Remote Controller.
» The MIC SET screen is displayed.

2. Select an appropriate connector in MOD Select (Remote ON) (Example: LAN), to input transmit audio
from the PC to the transceiver.

3. Click the close button to close the screen.

MIC SET X || ® Click
FOD Select
(Femate OM] Q@ Select
Y - |
MOD LEVEL

4 Remote control operation
See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function.
To display the Help file, click “Contents” in the Help menu on the Remote Controller application, or push the
[F1] key on your PC’s keyboard.

NOTE:
» DO NOT allow the PC to go into the sleep or standby mode while using the RS-BA1. Otherwise, it might not
work properly after the PC resumes normal activity.
* When not using the transceiver:
Follow the steps below to finish the remote control operation.
1. Disconnect the transceiver from the Remote Controller application, and then close the Remote Controller
application.
2. Disconnect the transceiver from the Remote Utility application, and then close the Remote Ultility application.
3. Turn OFF the transceiver and the PC.
@ If you check Software closing turns OFF the Radio., when you close the Remote Controller, the transceiver is also
turned OFF.
» When you manually select the transmit audio input connectors to be used after finishing the remote control
operation, right-click in the toolbar, or click “Remote Setting...” in the File menu to select.
® Regularly, it automatically returns to the original setting before you start the remote control operation.

TIP: Importing the repeater list
You can easily set the DV mode repeater information by importing the repeater list preset for each transceiver.
See the RS-BA1 Remote Controller’s Help file for importing details.




B O ABOUT THE REMOTE UTILITY

Setting your PC’s environment

Configure your PC’s environment in the Remote Utility.

The settings will take effect after rebooting the Remote Utility.

® When you first open the Remote Utility, the Settings screen is displayed.
After configuring the settings, you can display other setting screens.

Click “Options.” [ —per - ”
. “ . ” File Setup Wizarc| Options H

Click “Settings. Radimf‘sm,.ngg)gn!!(:k

» The “Settings” screen is displayed.

[ = 1@ Click
3. Configure the settings. e

N —

4. Click <OK> to save the settings. v
* “The changes will be effect after the application (3 Set X
restarts.” is displayed. PC Hame Q=<
5. CI'Ck <OK>. Control Port (UDP) W
® The settings will take effect after restarting the serpor (0@ | [2002
Remote Utility. adorortor) | [0
Network Cornecto @) [wred <]

Internet Access L\no FTTH -
Language e Englsh -

:
| @ Click
Remote Utility X
The changes will be effect after the applieation restarts.
|
® Click

O PC Name
Enter a name for your PC of up to 16 characters.
® DO NOT use the same name for more than one PC on your network.

@ Port numbers
Enter the port numbers of the Control, Serial, and Audio ports.
You should use the default port numbers for these ports.

© Network Connection
Select the network connection type.

O Internet Access Line
Select your internet access line type.

O Language
Select the software display language.
The selected language will be used as the Help file language.

NOTE: If you configure the remote control system through the Internet, and change the port number of the
Control, Serial or Audio port, you should reconfigure the port forwarding settings and the IP filter settings on your
router. (p. 4-4)
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Transceiver Registration

In the Remote Utility, register the transceivers that are physically connected to your PC.
See p. 2-2 to connect a transceiver to your PC.

< Adding a transceiver

i “ i ”? [B) 1com Remote Utiiny H - X
1. CIICk “Optlons. . » File Setup Wizard| Options @ Click
2. Click “Local/Server Settings. ot | s | mormesmne ] (@) Click

3. Click <Add>. o300 Settings..
* The “Purpose of use” screen is displayed. B

4. Select an option, and then click <Next >>.

@ If you select “Only accessible from this PC,” the
registered transceiver cannot be operated from v
other PCs. If you want to operate the Base station
transceiver from other PCs, select “Accessible from

Local/Server Settings 7 X
Other PCS . ” Registered Radio List | User Management
5. Set the transceiver information according to the —

displayed screen. Public
® See pages 2-7, 3-4, or 4-8 about the settings.

® Click
Register a Radio ? X
Purpose of use

Select the purpose of use of the radio.
Select the purpose of use of the racio below. and then click <Next>.

O Select

" Only accessible from this PC

& Accessible from other PCs!

@ Click
ook || meds | Cancel

TIP: When you add a transceiver from the Setup Wizard screen, click “Setup for a Server PC (The radio is
accessible by Remote PC(s).)” or “Setup for a Local PC (Directly connect the radio and PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
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Transceiver Registration

H H H lcom Remote Utility A =
< Changing a transceiver’s properties Qrermere i @ Click =

Click “Options.” ot [sene [ Lecsmerssing | (2) Click

Click “Local/Server Settings.” ICT300 W e
Select a transceiver. 11500k OV Adrers 54

Click <Properties>. v
Change the settings, and then click <OK>.

oo =

Local/Server Settings ? X

Registered Radio List | User Management

1C-7300

Public

\I\/\_/_\/\_/T

add | Delte | Properties | |

\ 4 @ Click

Radio Properties ? x
Connected Device Type - ¥ Public
Radio Name [1¢-7300
¥ v address [94 Baud Rate [115200

- COM Port/Audio Setting:

* Auo [1c-7300 COM=3 hd

 Manual

COM Port Number  [op3 ~

AF Input Device

[not used |
MOD Output Device

[Not used N T |

I? Displays Detected Auta Device

I Displays Virtusl Device:

Search
e

H H com Remote Utility . =
< Deleting a transceiver Sttt @ Click )

1. Click “Options.” o ene [ Coieesans ] (2) Click

2. Click “Local/Server Settings.” ||o7300 T ‘
3. Select a transceiver. T
4.

Click <Delete>. v

Local/Server Settings ? 53

Registered Radio List |USE, Management

|C-7300

Public

‘l\/\/w

Add Delete |  [roperties |

@ Click
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Transceiver Registration

< Adding a user who can access the transceiver

1.
2.
3.

Click “Options.”
Click “Local/Server Settings.”
Click the <User Management> tab.

1B 1com Remote Utility ® Cllck - 4

File Setup Wizarc Optlnns

ot s [ eieesene ] (2) Click

1C-7300 Settings...
Serial Data
115200bps 1V Address 94

v

Local/Server Settings ? 4
ey
1C-7300 hd

Registered Users Accessible Users
USERL (Admin

Add>x
<<Delete

Add Properties

Delete
Adding a user
1. Click <Add>.
Local/Server Settings T x
2. Enter a user ID of up to 16 characters, case I
'ti Ve Registered Radio List User Managemen!
sensitive.
® You cannot register an already registered ID. . ‘C'”“': =
Registered Users Accessible Users
3. Enter a password, of 8 ~ 16 characters, case TSERL Cadmm
sensitive. ad
® At least 2 different characters must be used. <<odete
4. Click <OK>.

To prevent unauthorized access:

Set a long and strong password so that no one can
possibly guess it. Mix upper and lower case letters,

numbers or characters.

umperﬁes

@ Click
Add User ? X
@ Enter e [US=R2 |
® Enter | @ s €
(Example. -ﬂ
USER0002) @) Click | To set the user as
an administrator,
click to puta
check mark.
Local/Server Settings ? *
Registered Radio List  User Management

Registered Users Accessible Users
USERL (Admin

Add>>
<<Delete

Add Properties




S  ABOUT THE REMOTE UTILITY

Transceiver Registration

< Adding a user who can access the transceiver (Continued)

To allow a user to use a transceiver

1. Select a transceiver that you allow the user to use.
2. Select the user. Ity 7
3- Cllck <Add>>>. Registered Radio List User Management @ Select

1C-7300 -

Registered Users Accessible Users

USERL (Admin

@ Click _ > | @ Click
<<Delete ’

|

Add Propertiss
Delete

v

Local/Server Settings ? X

Registered Radio List  User Management

1C-7300 hd

Registered Users Accssible Users
USERL (Admin Admin
d USERZ (Admin)

<<Delete

Add Properties

Delete

il

To inhibit a user to use a transceiver
1. Select a transceiver that you inhibit the user to

use Local/Server Settings ? X
) Registered Radio List User Management
2. Select the user. @ Select
. ¥ >
3. Click <<<Delete>. |
Registered Users guuis;qb\e Users

USERL (Admin’ TRy E—
. [0 1@ Click

<o || (3) Click
|

s

Add Properties

Delete

il
i

4

Local/Server Settings ? X
Registered Radio List  User Management

1C-7300 ~

Registered Users Accessible Users
USERL (Admin USERL (Admin

Add>3>
<<Delete

Add Properties

Delete

s
i
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Transceiver Registration

To change a user properties

1. Select a user.
2. Click <Properties>.

3. Change the settings, and then click <OK>.

To delete a user

Local/Server Settings. ?

Registered Radio List  User Management

1C-7300 -

Registered Users Accessible Users

@ Click |
’ <<Delete

w_|[ === @ Click
Delets

v

User Broperties ? X

userp  |TEER
passmord l—“m:“ % admin

@ Click

1. Select a user.
2. Click <Delete>.

5-6

Local/Server Settings 7

Registered Radio List User Management

1C-7300 -

Registered Users Accessible Users

@ Click |
<<Delete

Properties |

ad |
@ Click
A 4

Local/Server Settings ?

Registered Radio List ~ User Management |

1C-7300 -

Registered Users Accessble Users
A 3 USERL (Admin,

Add>>
<<Delete

Add Propertiss

Delete
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Server Registration

To connect to a Base station transceiver through the network, Remote PCs should first connect to a Server using
the Remote Utility. Before connecting, enter the Server information.

< Adding a Server

1. Click <Server List>.
2. Click <Add>.
+ Set the Server information according to the displayed
screen.
® When connecting to a Base station transceiver
through a LAN, see page 3-10 about the settings.
When connecting to a Base station transceiver
through the Internet, see page 4-12.

TIP: When you add a server from the Setup Wizard screen, click “Setup for a Remote PC (A radio with the Server
function)” or “Setup for a Remote PC (Connect through a Server PC).”
® To display the Setup Wizard screen, click “Setup Wizard” on the top menu.
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Server Registration

< Changing a server’s properties
1. Click <Server List>. [B tom Remere sy - x
2. Select a server. (.
3. Click <Properties>.

4. Change the settings, and then click <OK>.

File SetimWisard Ambinme  Haln

1C-7851

2 Select

Add | Remove I| Properties | | @ CIle il

Server Properties ? X

Server Desaription

Network Settings
Server Address Control Port

or Network Name

|1:-7351 | 50001
User ID Passwor d

=0 [==

I™ Disable the Server

[C=_1] @ click

< Deleting a server

1. Click <Server List>.
2. Select a server.
3. Click <Remove>.

rg Icom Remote Utility - b3

1C-7851

@2 Select

5-8



S  ABOUT THE REMOTE UTILITY

Connecting to a Server

< Connecting to a Server

Click <Server List>.

Select a server.

Click <Connect>.

“Connected” is displayed under the Server name

when the connection has succeeded.

@ If the connection fails, and an error screen is
displayed, solve the problem. (p. 7-1)

pON =

< Disconnecting from a Server

1. Click the <Server List> tab.
2. Select the connected server.
3. Click <Disconnect>.

5-9

1C-7851

2 Select

rg lcom Remot

File Setun Wi

Connected

2 Select

Remove Properties | Connect: Disconnect | @ click
d
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Connection setting

When the connection to the Server has succeeded, the Base station transceivers are displayed on the Radio List
screen. Select a transceiver from the list, then connect it to the network using the Remote Utility.
You have to configure the network audio quality and devices to connect.

® To control the transceiver, connect to the transceiver using the Control software.

List screen and then clicking <Connect>.

TIP: If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio

Click <Radio List>.

Select a transceiver.

Click <Settings>.

® For the transceivers that are “<<Connected>>" or
“Offline,” the Connection Setting cannot be changed.

4. Change the settings, and then click <OK>.

NOTE: When using the DUAL mode screen in the
Remote Controller, set the codec setting for
“AF Transmission” to 2 channels.

whh =

[B 1com Remote utiity

File Sehun Wisard  Ontinne  Haln

0-1[1=10=2]

2 Select

® Click |

| MOD | Mnmturl

Delete

v

IC-7851abc (IC-7851)
- Metwark Setting

[V AF Transmission [¥ MOD Transmission

Sample Rates [16kr1z =] [se -
Codecs |LPeM 2ch 16bit =] [t 1ch 1ebit -
Prebuffer (ms) O o —| 100
[¥ Retransmission Audio Data Reocm—mendedl
Device Settings
T T et =
Speaker [Default Device | [z ~]
Mic [Default Device | [ ~]

virtual Audio Sample Rates (change effective after the application restarts.) %8z =

5-10
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Connecting to a transceiver

If the connection setting is finished, you can simply connect to the transceiver by selecting it on the Radio List
screen and then clicking <Connect>.

< Connecting to a transceiver

1. Click <Radio List>.
2. Select a transceiver.
3. Click <Connect>.
4. Click <OK>,
« “<<Connected>>" is displayed under the radio name :
when the connection has succeeded. -
® If the connection fails, and an error screen is @ Select
displayed, solve the problem. (p. 7-2)

DI0-1 0=2]

Sattings Connact| @ click J MOD: | Manitar | Delete

Remote Utility x

Virtual serial port number is (2).

| @ click

< Disconnecting a transceiver
1. Click <Radio List>. T -

2. Select a transceiver with “<<Connected>>" under @ Clic
its name. IC-7851abc

3. Click <Disconnect>. << Connected >>
* “Do you want to disconnect the radio?” is displayed.

4. Click <Yes> to disconnect the transceiver.

10-1 0=2]

@2 Select

NOTE:

* Be sure to disconnect when not using the
transceiver. Otherwise, other users cannot connect
toit.

* The administrators can terminate a connection
between another user and a transceiver. If
“<<Connected>>" disappears while connecting to = | [ @ Click || ]

a transceiver, the administrator may terminate the

connection. '

Remote Utility

Do you want to disconnect the radio?

1|. @ Click
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Adjusting audio level using the Remote Utility application

While connected to a Base station transceiver, you can adjust the received and transmit audio volume through the

network using the Remote PC’s Remote Utility.

The description in this section is based on the assumption that the connection to the transceiver has succeeded.

(“<<Connected>>" is displayed under the radio name.)

< Adjusting received audio volume
1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <AF>.

4. Slide the adjustment bar on the Volume field up or
down to adjust the received audio volume level.
® Click <Mute> to mute the audio, and click once again

to hear the audio.
5. Click <Close> to close the screen.
NOTE:

» The AF adjustment bar on the Volume field
moves together with the AF control of the Remote
Controller. However, if you use another control
software, the audio volume level on the network
can only be adjusted with the Remote Utility.

* You cannot adjust the received audio volume level
of the transceiver’s speaker, with the Remote
Utility. Use the AF control on the transceiver to
adjust it.

* When setting the codec setting for “AF
Transmission” to 1 channel, the volume level of
both right and left are the same.

IC-7851abc

<< Connected 2> 1

2 Select

st | [ ] oo @ Click |
h 4

1C-7851abe (IC-7851) ? %
Volume Recording
i ‘ Sample Rates [16kt1z |
! Codecs [tcm 1eh 1ebie =]
T T & MW Il Open Folder
i 00:00:00
odB 0dB
L AF R
Mute Mute Rec Folder
I LR Mix ‘c‘ \sers\ \Documents\icom \Remotelty rec
. Close @ i
L @ Adjust Click

5-12

< Adjusting transmit audio volume
1. Click <Radio List>.

2. Select a transceiver with “<<Connected>>" under
its name.

3. Click <MOD>.

4. Select “Mic” in “MOD Select.”

5. Slide the adjustment bar on the Volume field up or
down to adjust the transmit audio volume level.

6. Click <Close> to close the screen.

NOTE: You cannot adjust the modulation input
level of the transceiver with the Remote Utility.
Adjust the modulation input level of the transceiver
in the transceiver’s Set mode, or using the Remote
Controller. (p. 6-2)

2 Select

seongs | [ | pumea| it ® Click - |

A 4

IC-7851abc (IC-7851) 7 X

Volume MOD Select

| & Mic Default Device |

@ Select

e i |

VA

" File

® Adjust

00:00:00

Mic " Notused

® Click
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Recording and playback function

While connected to a transceiver, you can record the received audio and save it into the PC’s hard disk using the
Remote PC’s Remote Utility.

Also, you can transmit an audio file to the radio using the Remote Utility.

The description in this section is based on the assumption that the connection to the transceiver has succeeded.
(“<<Connected>>" is displayed under the radio name.)

< Recording received audio

1. Click <Radio List>.
2. Select a transceiver with “<<Connected>>" under

[E lcom Remote Utility - X

its name.
3. Click <AF>.
4. Click < ®|> to start recording.

® While recording, click < 11/ > to pause. : —
5. Click < m > to stop recording. @ Select
TIP:
» When you click <Open Folder>, the folder in which

the recording file is saved is displayed.

- If you want to change the recording folder, click [z | [ core | scrres] ® Click |
< - >, then select a folder on the Browse For
Folder screen. V

* Adjust the sample rate frequency and codec

; ; . Record butt
to record the audio according to the recording ecord button
purpose. When you record the audio received Stop button
from the network, we recommend that you set the —— Pause button
same sample rate frequency and codec that are
programmed on the Connection Setting screen. R P
‘ | 5| nple R tes |
Cldecs [Pemichssoe =]
o mn senrii_e——— Open the folder
TV 0T 5 Recording file name
- e || Elapsed time
L AF R
Mute Mute Rec Folder
[ LR Mix ‘C‘-users\ \Documents\icom\RemoteUty \yec 7 J
I Close I |

Recording folder name Folder browse button
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Recording and playback function

< Playing back and transmitting an audio file

1. Click <Radio List>. (B -
2. Select a transceiver with “<<Connected>>" under

its name.
3_ C||Ck <MOD>_ << Connected »>
4. Select “File” in “MOD Select.”
5. Click <Open> to select an audio file* to play or

transmit.

* Only uncompressed, linear, PCM WAV files are

supported.

6. Click < » > to start playing/transmitting.
® While playing or transmitting, click < 1. > to pause.
7. Click < m> to stop playing/transmitting.

Settings | Dismnne:tl A @ Click J

TIP: You can also use the Remote Controller’s Voice A 4

Memory function to play back or transmit an audio

file. See the Remote Controller’s help file for details. — Playback button
To display the help file, click “Contents” in the Help —— Stop button
menu on the Remote Controller, or push the [F1] key —— Pause button
on your PC’S keyboard IC-7851abc (IC-7851) 7 X

Volume MOD Select

" Mic [|=fault|Jevic|:
™ v Audio Ij:oM_|aui|a-1
T © Fie > m1| [ &= e — Open the folder
C\Jsersinp Uty\ Audio file name
00:00:00 Elapsed time

od8
File " Notused

Close
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Monitoring another user from the Server PC

When you are operating a Server PC, and another user is accessing a Base station transceiver that is physically
connected to your PC, you can monitor the received and transmitted audio.
® To monitor, you should connect a speaker to your PC.

1. In the Server PC’s Remote Ultility, click the <Radio . - X
List> tab. ‘ D Click

2. Select a transceiver with “Busy” under its name.

® The operating user’s name (PC Name that the
Remote PC set in the Network Setting screen), and
its IP address are displayed under “Busy.”

Click <Monitor> to display the Monitor screen.

Click <TX Monitor> to turn the Transmit Monitor

function ON or OFF.

Click <RX Monitor> to turn the Receive Monitor

function ON or OFF.

Slide the adjustment bar on the Volume field up or

down to adjust the monitoring audio volume level.

5. Click <Close> to close the screen. s | ot | o] | s [L]] 3 Click
|

B w

TX Manitor .
=1 @ Click

@ Adjust

© Click

.- @@ 4
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Disconnecting another user

The administrators and the Server PC can terminate a connection between another user and a transceiver.

Click <Radio List>. [Areomencev, - x
Select a transceiver with “Busy” under its name. o] (D Click
® The operating user’s name (PC Name that the user e
set in the Settings screen), and its IP address are
displayed under “Busy.”
3. Click <Disconnect>.
* “The radio is in use by a remote PC. Do you want to
disconnect?” is displayed. @ Select
4. Click <Yes> to terminate the connection.
® When you terminate a connection, no dialog is
displayed on the disconnected user’s Remote Utility.

N =~

Busy

UDI0-1 [=1 0=2]

Settngs | comect | [Discormect @ Click J Maritor Delete

Remote Utility

The radia is in use by a remote PC. Do you want to disconnect?

_ @ Click
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Connect to the Base station transceiver.
(p. 2-11, p. 3-14, p. 4-16)

About the Remote mode Open the Connect Setting screen.
(p. 6-2) (p. 2-11, p. 3-14, p. 4-16)

B R|-BA1 Remo|e Control
File |View Opifon Help

FILTER

FILTER FILTER
MAIN — TWIN-PBT — SUE

TRANSMIT :__ 0 o
ANT1 P.AMP 1
¥ TUNER AGC-FAST
TonE | R-1.2k R-15k

| 3 MIUSEI) Fiiz) (75K PUSEM FiLT TSk - R
MONI 14.100.26 __._f'ﬂ['f.__”m'm
CE  1:-BLANK N[ (")

e

BE-IN

- R . I NOTCH I NOTCH
I AFF I APF
LR 1 TFF
TEW WIDE U DIGISEL U DIGISEL
MODE
RTTY PSK AM I TONE

MAIN — RF GAIN — SUB B DUALW B SPLIT
P

P e
(« ) () MEMORY

o S

MP-W MP-R
MAIN — AF -#-50QL — SUB

MEMO GROUP
v A v A
DOWN  UP DOWN UP

MW M-CLR

To use transmit audio input from the PC (p. 6-2)

TIP: See the RS-BA1 Remote Controller’s Help file for remote operation details, such as how to change the
frequency or how to turn ON each function. To display the Help file, click “Contents” in the Help menu on the
Remote Controller application, or push the [F1] key on your PC’s keyboard.

The windows that are displayed by right-clicking on each button on the Remote Controller, see the Operating
Guide at the end of this manual.
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To use transmit audio input

from the PC

To use the transmit audio input from the PC function
when remotely controlling the transceiver using the
Remote Controller, configure the following settings,
according to the connection between the transceiver
and the Server PC.

If you operate from the Remote PC, confirm the
transceiver is connected to the Server PC.

1. Connect to a transceiver with the Remote
Controller.

2. Click <MIC SET> to open the MIC SET screen.

3. Select an appropriate connector in MOD Select
(Remote ON), to input transmit audio from the PC
to the transceiver.
® The options differ, depending on the transceiver

selected in Model on the Connect Setting screen.

4. Right-click <MOD LEVEL> to rotate clockwise, or
left-click it to rotate counterclockwise, to adjust the
input level from the connector.

5. Click < £ > to close the screen.

MIC SET > || ® Click
MOD Select
[Rermate OMN] 3 Select
-
MOD LEVEL
O @ Adjust

6-2

About the Remote mode

When connected to the transceiver, the Remote
Controller automatically turns ON the Remote mode.
While the Remote mode is ON, the Remote Controller
transmits CIl-V commands not only to check the
transceiver’s current state, but also to remotely control
it.

When you want the Remote Controller to only check
the transceiver’s current state, or when you want

to inhibit the Remote Controller from transmitting
control commands while you manually operate the
transceiver, turn OFF the Remote mode.

To turn OFF the Remote mode
Click the Remote icon in the toolbar, or click
“‘Remote OFF” in the File menu.

To turn ON the Remote mode
Click the Remote icon in the toolbar, or click
“‘Remote ON” in the File menu.

® You can select the desired connector(s) for
transmitting audio input when the Remote mode
is OFF. See the Remote Controller’s Help file for
“Remote Setting” details.

NOTE: DO NOT allow the PC to go into the sleep or
standby mode while using the RS-BA1. Otherwise, it
might not work properly after the PC resumes normal
activity.
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Using the RC-28

If you connect the optional RC-28 REMOTE ENCODER
to your PC, you can use the RS-BA1 and feel like you
are operating the actual transceiver’s MAIN dial.

1. Connect the RC-28 to the PC that has RS-BA1
installed.
® When you connect the RC-28 to the PC for the
first time, wait until “Device driver software installed
successfully.” is displayed.

NOTE: DO NOT connect the RC-28 to the PC with
other than the supplied USB cable, or through any
USB hub. The RC-28 may not work properly.

A‘%M

fo a [USB] port USB cable (supplied)

—— [LINK] indicator

* The [LINK] indicator on the RC-28 lights green.
* Now you can control the assigned functions of the RS-
BA1 using the RC-28.

TIP: If the [LINK] indicator does not light, check the

following.

1. Click “USB Dial...” in the Option menu to open
the USB Dial Setting screen.

2. If Select Device is set to “Not Use,” set it to the
RC-28’s serial number.
(Example: RC-28 02XXXXX)
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The following are possible causes and solutions for the problem you are experiencing.
If you cannot solve the problem after trying these solutions, please contact your nearest dealer or Icom Service
Center.

Problem: Cannot access a Server from a Remote PC with the Remote Utility
® You can configure the Server information on the Server Properties screen. (Server List screen = <Properties>)

“Connection Failed” is displayed under the Server name

IC-7851 Possible cause 1

An incorrect IP address, domain name, or network name (Computer name) is entered
Connection to request a connection to the Server.
Failed @ If the Remote Utility cannot get the Server’s IP address using the domain name or

network name (Computer name) that you entered, “Cannot resolve the name” is
displayed next to the name.

Solution

1. Check the Server’s IP address, domain nhame, or network name (Computer
name). (pp. 3-2, 4-2)

2. Enter the Server’s correct IP address, domain name, or network name in Server
Address or Network Name on the Server Properties screen.

Possible cause 2
The control port number is different than that of the Server.

Solution

1. Check the Server’s control port number®. (pp. 2-2, 4-4)

2. Enter the correct port number into Control Port (UDP) on the Sever Properties
screen.
* The default number is “50001.”

Possible cause 3
The virtual driver is not installed in the Remote PC.

Solution
Install the virtual driver in the Remote PC.
(See the RS-BA1 PREPARATION for details.)

“Logon Failed” is displayed under the Server name

IC-7851 Possible cause
The user ID or password is different than the one in the Base station.
'EDFJID; Solution
S 1. Confirm the Remote PC information registered in the Base station.
(pp. 3-2, 4-6)

2. Enter the correct user ID and password into User ID and Password on the Sever
Properties screen.

“Disabled” is displayed under the Server name

IC-7851 Possible cause
The Server is set to “Disable,” to inhibit connecting to it.
Disabled Solution

Enable the Server by removing a check mark from Disable on the Sever Properties
screen.

7-1



7/  TROUBLESHOOTING

NOTE: If you could not solve the problem after trying the solutions, check the following on the Base
station.

When connecting to the network directly:
* |s the transceiver turned ON or Remote standby mode?
* Is Network Control set to “ON"? (pp. 3-2, 4-6)

When connecting to the network through a PC:

* |s the Remote Utility activated?

* |s your Remote station information registered on the Remote Utility’s User List screen? (p. 5-4)
* |s the Remote Utility added as an exception in the Firewall? (p. 1-1)

Problem: Cannot access a transceiver with the Remote Utility

The description in this part is based on the assumption that the connection to the Server has succeeded.
» “Connected” is displayed under the Server name when the connection is successful.

Possible cause
Another user is currently operating the transceiver.

Solution

Wait for “Busy” to disappear.

@ If you are operating as an administrator or a Server, you can terminate a
connection between another user and a transceiver. (p. 5-16)

“Connect Error” is displayed under the radio name

IC-7851abe Possible cause 1
. The serial port number (default: 50002) or the audio port number (default: 50003) is
OHREEt not connected.

Errar

Solution
Check the Firewall settings for the Remote PC.
When using the Internet, also check the router’s port forwarding settings. (p. 4-4)

Possible cause 2
Access to the selected transceiver is inhibited by the Server PC.

Solution
Allow the Remote PC to access the transceiver with the Server PC’s Remote Utility.
(p. 5-4)
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IC-7851abc Possible cause 1
Other applications are using the COM port.

Avdio

Solution
If other applications are running at the same time, close them.

Possible cause 2
Started the Remote Utility right after the PC has booted.

Solution
Wait for a while after the PC has booted, and then start the Remote Utility.

Possible cause 3
An audio device or COM port has been added to the PC, or removed from the PC.
For the USB device, the USB port number has been changed.

Solution
The COM port number or the audio device name may have been changed.
Reregister the radio on the Registered Radio List screen. (p. 5-2)

Possible cause 4
The audio or serial wiring is disconnected.

Solution

If you are using a USB serial conversion cable or a USB audio cable, make sure the
USB cabile is firmly connected.

Make sure the 3.5 (d) mm (1/8”) audio cable is firmly connected.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

* |s the transceiver turned ON?

* Are the correct COM port number and audio device to which the transceiver is connected selected on
the Radio Properties screen?
(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

* Is the Server PC not directly accessing the transceiver using the Remote Controller, without having
used the Remote Utility to connect to the transceiver?
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Problem: Cannot access a transceiver with the Remote Controller

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < E > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.

The description in this part is based on the assumption that the connection to the transceiver using the Remote

Utility has succeeded.

» “<<Connected>>" is displayed under the radio name when the connection is successful.
When connecting to the transceiver through the network using the Remote Utility

Possible cause 1

In CI-V of the Remote Controller’s Connect Setting screen, the CI-V settings are different than that in the
Remote Utility.

Solution

On the Connect Setting screen, click <Search>, and then select the correct transceiver in the Remote
Utility menu.

» The CI-V settings are automatically loaded from the Remote Ulility.

Possible cause 2
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.

NOTE: If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* |s the transceiver turned ON or in the Remote standby mode?

When connecting to the network through a PC:

* Are the same CI-V address and baud rate that are programmed into the transceiver set on the Radio
Properties screen?

(Option = Local/Server Settings = Registered Radio List screen = <Properties>)

When directly accessing the transceiver without using the Remote Utility

Possible cause 1
An incorrect COM port number is set on the Remote Controller’s Connect Setting screen.

Solution
1. Check the COM port to which the transceiver is connected, on your PC’s Device Manager.
2. Set the correct COM port number to COM Port on the Remote Controller’s Connect Setting screen.

Possible cause 2
The CI-V address or baud rate is different than that are set into the transceiver.

Solution
1. Check the transceiver’s Cl-V address and baud rate.
® See the transceiver’s instruction manual for details.
2. Enter the transceiver’s correct Cl-V address in Cl-V address (Radio), and select the transceiver’s
correct baud rate in Baud rate (bps), on the Remote Controller’s Connect Setting screen.
@ If the radio’s baud rate is set to “Auto,” select “19200” in the Baud rate (bps) menu.
@ If you are using the Spectrum Scope function with the IC-7851, IC-7850, IC-7760, IC-7610, or IC-7300 using
a USB for the connection, select “115200” in the Baud Rate menu.

Possible cause 3
Other applications are using the COM port.

Solution
If other applications are running at the same time, close them.
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Problem: The DUAL mode screen of the Remote Controller cannot be displayed

® To access a transceiver with the Remote Controller, configure the connection settings on the Connect Setting
screen. Click < E > in the toolbar, or click “Connect Setting...” in the Option menu to open the screen.
Possible cause

An incorrect transceiver’s model is set on the Remote Controller’s Connect Setting screen.
Solution

Select a model named with “(DUAL).”

Problem: Cannot properly control the transceiver with the Remote Controller
Possible cause
The same CI-V address is being used by other control software.
Solution

Select an address other than “EQ” in CI-V Address (RS-BA1) on the Remote Controller’'s Connect
Setting screen. However, this solution does not always solve the problem.

NOTE:

If you could not solve the problem after trying the solutions, check the following.
* Are there any radios that have the same CI-V address in the system?
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Problem: The received audio cannot be heard.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.
» “<<Connected>>" is displayed under the radio name when the connection is successful.

Possible cause 1
The speaker is not turned ON, or the volume level is too low.

Solution
Turn ON the speaker, or adjust the volume level.

Possible cause 2
An earphone or other device is connected to the computer in place of the speaker.

Solution
Disconnect the device.

Possible cause 3
The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Speaker on the Connection Setting screen.

(Radio List screen = <Settings>) (pp. 3-12, 4-14)

@ If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Speaker, keep that in mind.

Possible cause 4
The volume level of the audio device is set to too low on your PC.

Solution

Adjust the volume level of the audio device. (p. 1-3)

® The PC has the Volume Mixer function that can adjust each application’s audio level. Confirm that the
Remote Utility or the control software is not muted, or set it to an appropriate volume level.

Possible cause 5
Audio output is disabled in the Remote Utility.

Solution
Insert a check mark in AF Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 6
The volume level is too low, or the mute is turned ON in the Remote Utility.

Solution
Adjust the volume level on the Received Audio Adjustment screen.
(Radio List screen = <AF>) (p. 5-12)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

* Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?
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Problem: The received audio cannot be heard in the DUAL mode.

® See also “Problem: The received audio cannot be heard.”

Possible cause 1
The codec setting for the received audio is set to 1 channel on the Remote Utility’s Settings screen.

Solution
Set the codec setting for the received audio to 2 channels.

Possible cause 2
When the transceiver is connected to the PC with a USB cable, the audio device setting is incorrect.

Solution
Set the microphone’s Default Format to 2 channels on the Windows Sound setting screen.
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Problem: The transmit audio cannot be output.

The description in this part is based on the assumption that the connection to the transceiver has succeeded.

» “<<Connected>>" is displayed under the radio name when the connection is successful.

® To check the Remote PC’s transmit IF signals, use the Transmit Monitor function with the Server PC’s Remote
Utility, or place a receiver near the Remote PC or Server PC.

Possible cause 1
The microphone is not turned ON, or the input level is too low.

Solution
Turn ON the microphone, or adjust the input level.

Possible cause 2
The appropriate audio device is not selected in the Remote Utility.

Solution

Select the appropriate audio device in Mic on the Connection Setting screen.

(Radio List screen = <Settings>) (p. 5-10)

@ If you connect a new USB audio device to your PC, the audio device which is selected as a default
device in your PC can be changed. If you select “Default Device” in Mic, keep that in mind.

Possible cause 3
The input level of the audio device is set to too low on your PC.

Solution
Adjust the input level of the audio device. (p. 1-3)

Possible cause 4
Audio input is disabled in the Remote Utility.

Solution
Insert a check mark in MOD Transmission on the Connection Setting screen.
(Radio List screen = <Settings>)

Possible cause 5
The input level is too low in the Remote Utility.

Solution
Adjust the input level on the Transmit Audio Adjustment screen.
(Radio List screen = <MOD>) (p. 5-12)

Possible cause 6
An incorrect connector is selected in the Remote Controller.

Solution
Select the proper transceiver’s connector which is connected to the Server PC, in MOD Select (Remote
ON) on the Remote Controller’s MIC SET screen. (p. 6-2)

NOTE:
If you could not solve the problem after trying the solutions, check the following.

When connecting to the network directly:
* Is Network AF set to an appropriate level in the Others set mode?

When connecting to the network through a PC:

* Is the volume level of the audio device that the transceiver is connected to set to an appropriate
level?
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Problem: The received audio is intermittent

Possible cause 1
The network data transfer is excessive.

Solution

Select a lower sampling rate value in Sample Rates, or a different codec in Codecs, on the Connect

Settings screen. (Radio List screen = <Settings>)

® First, select the lowest value. If the received audio is not interrupted with the setting, try a higher
value, and adjust to an appropriate value.

Possible cause 2
The capacity of the prebuffer is not enough.

Solution

Select a longer value in Prebuffer (ms) on the Connection Setting screen.

(Radio List screen = <Settings>)

® Select as short a value as possible, because longer prebuffers can cause a delay, and make it difficult
to adjust the audio level.

Possible cause 3
Your PC is overloaded.

Solution 1
Shutdown other applications, if running.

Solution 2
Reduce the number of transceivers you are accessing with the Remote Utility.

NOTE:

* If you are accessing the transceiver through a network, removing a check mark from Retransmission
on the Connection Setting screen can solve the problem.
(Radio List screen = <Settings>)

* You can check the simplified packet round trip time, and the average packet loss on the Remote
Utility’s Server List screen.

IC-7851

Connected

Packet round trip time Average packet loss

Problem: The connect settings cannot be changed

IC-7851abe Possible cause 1

The transceiver is “Offline.”

Offline

. Solution

Click <Connect> on the Server List screen to connect to the server.

IC-7851abc Possible cause 2

“<<Connected>>" is displayed.

<< Connected >> .
Solution

Click <Disconnect> on the Radio List screen to disconnect from the transceiver.
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Problem: The connect settings cannot be changed using the Remote Controller

Possible cause
The Remote Controller is connected to the transceiver.

Solution
Click < @)l > to disconnect it from the transceiver.
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Remote Controller Operating Guide (DUAL mode screen)

The following windows are displayed by right-clicking on each button on the Remote Controller.

® There are some windows that are displayed by left-clicking. The buttons are marked in white.
(Example: Memory Channel Editor).

® The windows whose title are with “(MAIN)” are displayed when you select the MAIN band.
When you select the SUB band, “(SUB)” is displayed instead.

® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.

TIP:

* You can select either “Knob” or “Slider” on the Set Mode screen to adjust each setting.
(Set Mode > Controllers > Control Type)

» Some windows are not displayed, depending on the connected transceiver.
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Remote Controller Operating Guide (Single mode screen)

The following windows are displayed by right-clicking on each button on the Remote Controller.
® There are some windows that are displayed by left-clicking. The buttons are marked in white.
(Example: Memory Channel Editor).
® The windows that are displayed by right-clicking can also be displayed by right-clicking on the screen icons.

TIP:

* You can select either “Knob” or “Slider” on the Set Mode screen to adjust each settings.

(Set Mode > Controllers > Control Type)

» Some windows are not displayed, depending on the connected transceiver.
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